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1 Introduction

This manual provides basic knowledge required to use the
MCT 10 Set-up Software with Danfoss Drives VLT frequency
converters. Familiarity with the following is assumed

• MS®-WindowsTM at user level

• Set-up, process knowledge and operation of
frequency converters

• Use of and linkage with communication
equipment

The manual does not provide any detailed information
regarding specific applications or possible solutions and
related parameter combinations in the set-up and use of a
frequency converter. Refer to the Operating Instructions and
Design Guide of the frequency converter. Any update of
the manual and instructions related to the MCT 10 Set-up
Software is available on the Danfoss Drives Homepage
www.drives.danfoss.com

Familiarity with the PC or PLC master of the system is
assumed. Issues regarding hardware or software produced
by other manufacturers are beyond the scope of this
manual, and are not the responsibility of Danfoss.

Refer to the appropriate manuals for more information
about master-to-master communication, or communication
to a non-Danfoss follower.

1.1 How to Read this Document

1.1 Intended Use 

The MCT 10 Set-up Software enables full system configu-
ration and control. With MCT 10 Set-up Software it is
possible to monitor the entire system more effectively for
faster diagnosis, and better preventive maintenance.

MCT 10 Set-up Software is designed as an interactive
commissioning tool for quick and easy commissioning of
the following frequency converter series

• VLT 2800

• VLT 4000

• VLT 5000

• VLT 6000

• VLT 8000

• VLT HVAC Drive FC 102

• VLT AQUA Drive FC 202

• VLT AutomationDrive FC 300

• VLT Decentral Drive FCD 300

• VLT DriveMotor FCM Series

The MCT 10 Set-up Software can be used as follows:

• For planning a new communication network off-
line. The MCT 10 Set-up Software contains a
complete database with all Danfoss Drives
products.

• For commissioning frequency converters online

• For easy replacement of a frequency converter

• For easy expansion of network with more
frequency converters

• For back-up of parameter settings of frequency
converters in a communication network.

• The MCT 10 Set-up Software supports Profibus
DP-V1 communication via a Master class 2
connection. This will eliminate the need for an
extra communication network.

The communication framework part of MCT 10 Set-up
Software is handling the control of the fieldbusses. It
provides enhanced capabilities allowing multiple
concurrent fieldbus communication. Several fieldbusses can
be configured and combined in the same Network within
MCT 10 Set-up Software.

NOTICE
If several fieldbusses are created with the same type,
make sure they are configured with different scan
ranges.

1.2 System Requirements

To use the MCT 10 Set-up Software, the IBM-compatible
personal computer must meet the following minimum
system requirements:

• a Pentium PIII 350 Mhz or compatible
microprocessor

• 256 MB of RAM (512 MB of RAM Recommended)

• a CD-ROM drive

• 200 MB of available space on the hard drive;

MCT 10 Set-up Software runs on the following MS
Windows versions

• WindowsTM 2000 (with service pack 3 or higher)

• WindowsTM XP (Professional when using Siemens
Profibus CP Cards)
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• WindowsTM Vista

• WindowsTM 7 32/64 bit Editions

1.3 Software Modules 

The MCT 10 Set-up Software is supplied in 2 modules:

MCT 10 Set-up Software for

• setting of the frequency converter parameters

• copying of parameter sets to and from a
frequency converter

• documentation/print-out of set-up, including
diagrams

• servicing and fault analysis

APoss program for

• creating APoss programs.

1.3.1 Features of MCT 10 Set-up Software

• Project-oriented PC tool, one tool for all series

• Links to all Windows applications possible

• Supports Siemens CP PCMCIA- and PCI cards, for
Profibus DP-V1 Master Class 2 connection

• Support of standard interfaces: COMx, USB, RS
232 (Flux)

• Siemens PG/Field PGs already have the necessary
hardware

• View is highly individually configurable

• Downwards compatibility with Dos-Dialog (*.mnu)
and WinDialog (*.vlt)

• Windows™ Explorer-like interface for quick and
easy start up and navigation

Illustration 1.1 Connect up to 126 nodes using a repeater.
Without a repeater, connect up to 31 nodes.

1.4 Versions

MCT 10 Set-up Software is available in 2 versions

• MCT 10 Set-up Software Basic is available free of
charge, downloadable from www.vlt-software.com

• MCT 10 Set-up Software Advanced can be
purchased under the order-number 130B1000.

Version supports MCT 10 Set-up
Software Advanced

MCT 10
Set-up
Software
Basic

Frequency converters per
project

Unlimited Four

FC protocol Yes Yes

USB Yes Yes

Profibus DP-V1 Yes Yes

Profibus DP-V1
Handling Multiple Danfoss
Nodes Concurrently

Yes (improved
performance)

N/A

Ethernet-TSC Yes N/A

Logging and Scope function 8 Channels 2
Channels

Real Time Logging from Drive 4 Channels N/A

Alarm display Yes View only

MCO 305 Yes Yes

Graphical Smart Logic Contr. Yes Yes

VLT5000 to FC 302
Conversion Wizard

Yes Yes

FC to FC Conversion Wizard   

Import 3000.XLS to FC 302 Yes N/A

Motor Database Yes N/A

Extended Cascade Controller Yes No

Drive File System Yes N/A

Table 1.1 Features of the Basic and Advanced Versions

1.5 Further Information

The following literature related to MCT 10 Set-up Software
is available.

• Profibus DP V1 Design Guide

• Design Guide for the relevant frequency
converter(s)

Refer to drives.danfoss.com for frequently asked questions
and additional information.
It is also possible to find video training material on this site
for operating MCT 10 Set-up Software.
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2 Safety

2.1.1 Legal Information, Copyright and
Revisions

This publication contains information proprietary to
Danfoss and is protected by Copyright laws of Denmark,
international treaties and most other countries. All
trademarks in this publication are property of the
respective companies. Danfoss and the Danfoss logotype
are trademarks of Danfoss A/S. All rights reserved.

Although Danfoss has tested and reviewed the correctness,
completeness and documentation of this publication,
Danfoss makes no warranty or representation, neither
express or implied, with respect to this publication,
including but not limited to its quality, correctness,
completeness, performance, or fitness for a particular
purpose.

Danfoss reserves the right to revise, update and change
this publication at any time without prior notice or specific
obligation to inform former or present users of such
revisions or changes.

2.2 Safety Precautions

WARNING
HIGH VOLTAGE WARNING!
The voltage of the frequency converter is dangerous
whenever connected to mains. Incorrect installation of
the motor, frequency converter or fieldbus may cause
damage to the equipment, serious personal injury or
death. Consequently, the instructions in this manual, as
well as national and local rules and safety regulations,
must be complied with.

Safety Regulations
1. The mains supply to the frequency converter

must be disconnected whenever repair work is to
be carried out. Check that the mains supply has
been disconnected and that the necessary time
has elapsed before removing motor and mains
supply plugs.

2. The [OFF] key on the LCP does not disconnect
the mains supply and consequently it must not
be used as a safety switch.

3. The equipment must be properly earthed, the
user must be protected against supply voltage
and the motor must be protected against
overload in accordance with applicable national
and local regulations.

4. The earth leakage current exceeds 3.5 mA.

5. Protection against motor overload is not included
in the factory setting. If this function is desired,
set 1-90 Motor Thermal Protection to data value [4]
ETR trip 1 or data value [3] ETR warning 1.

6. Do not remove the plugs for the motor and
mains supply while the frequency converter is
connected to mains. Check that the mains supply
has been disconnected and that the necessary
time has elapsed before removing motor and
mains plugs.

7. The frequency converter has more voltage
sources than L1, L2 and L3, when load sharing
(linking of DC intermediate circuit) or external 24
V DC are installed. Check that all voltage sources
have been disconnected and that the necessary
time has elapsed before commencing repair work.

CAUTION
RISK OF UNINTENDED START!
This software enables remote control of a frequency
converter and can start an electric motor which may
drive dangerous machinery. Always observe the
necessary caution when using the software and take
suitable measures to prevent personal injury and
damage to machinery and equipment.

Warning against unintended start
1. The motor can be stopped with digital

commands, bus commands, references or a local
stop, while the frequency converter is connected
to mains. To ensure personal safety, these stop
functions are not sufficient to avoid unintended
starts. In such cases, the mains supply must be
disconnected or the Safe Torque Off function
must be activated.

2. The motor may start while setting the
parameters. If this means that personal safety
may be compromised (e.g. personal injury caused
by contact with moving machine parts), motor
starting must be prevented, for instance by use
of the Safe Torque Off function or secure discon-
nection of the motor connection.

3. A motor that has been stopped with the mains
supply connected, may start if faults occur in the
electronics of the frequency converter, through
temporary overload or if a fault in the power
supply grid or motor connection is remedied. To
ensure personal safety, disconnect mains supply
or activate the Safe Torque Off function.

Safety VLT® MCT 10 Set-up Software
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4. Control signals from, or internally within, the
frequency converter may in rare cases be
activated in error, be delayed or fail to occur
entirely. When used in situations where safety is
critical, e.g. when controlling the electromagnetic
brake function of a hoist application, these
control signals must not be relied on exclusively.

WARNING
Touching the electrical parts may be fatal - even after
the equipment has been disconnected from mains.

Also make sure that other voltage inputs have been
disconnected, such as external 24 V DC, load sharing
(linkage of DC intermediate circuit), as well as the motor
connection for kinetic back-up.
Systems where frequency converters are installed must, if
necessary, be equipped with additional monitoring and
protective devices according to the valid safety regulations,
e.g law on mechanical tools, regulations for the prevention
of accidents etc. Modifications on the frequency converters
by means of the operating software are allowed.

Hoisting applications
The frequency converter functions for controlling
mechanical brakes cannot be considered as a primary
safety circuit. There must always be a redundancy for
controlling external brakes.

Protection Mode
Once a hardware limit on motor current or DC-link voltage
is exceeded the frequency converter enters Protection
mode. Protection mode means a change of the PWM
modulation strategy and a low switching frequency to
minimise losses. This continues 10 s after the last fault and
increases the reliability and the robustness of the
frequency converter while re-establishing full control of the
motor.
In hoist applications, Protection mode is not usable because
the frequency converter is usually not able to leave this
mode again and therefore it extends the time before
activating the brake – which is not recommendable.
Protection mode can be disabled by setting 14-26 Trip Delay
at Inverter Fault to zero which means that the frequency
converter will trip immediately if one of the hardware
limits is exceeded.

NOTICE
It is recommended to disable protection mode in
hoisting applications (14-26 Trip Delay at Inverter Fault =
0)

WARNING
The DC link capacitors remain charged after power has
been disconnected. To avoid electrical shock hazard,
disconnect the frequency converter from mains before
carrying out maintenance. When using a PM-motor,
make sure it is disconnected. Before doing service on the
frequency converter wait at least the amount of time
indicated in Table 2.1

Voltage [V] Power [kW] Waiting Time [min]

380-500 0.25-7.5 4

 11-75 15

 90-200 20

 250-800 40

525-690 37-315 20

 355-1000 30

Table 2.1 Discharge Time

For further information, see www.danfoss.com/Busines-
sAreas/DrivesSolutions/Documentations/Technical
+Documentation.htm

Safety VLT® MCT 10 Set-up Software
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3 Installation and De-installation 

3.1 Introduction

The MCT 10 Set-up Software and SyncPos modules are
installed by means of a multilingual, self-explanatory instal-
lation program.

3.1.1 Start the Installation Program

1. Select the sub-menu Run from File in Windows
programming control.

2. Enter: [DRIVELETTER]:\SETUP in the command line
and press <Return>.

3. Follow the instructions of the installation
program.

When the installation process is complete, the MCT 10 Set-
up Software can be found on the following path:

Illustration 3.1 Path for MCT 10 Set-up Software

3.1.2 MCT 10 Set-up Software Language

The default language for the MCT 10 Set-up Software is
English. Change the language of operation as follows.

1. Select Options from the main menu, then select
Language.

2. Select the desired language from the scrollbar
and close the window.

3. Close and restart MCT 10 Set-up Software to
activate the language setting.

Change language
Select the language version during installation.

NOTICE
The selected language is default.

Illustration 3.2 Select Language

NOTICE
Change of language affects parameter language. If an
external LCP display is connected to the frequency
converter, the change of language version does not
affect the display language.

3.1.3 De-installation 

NOTICE
The following procedure is only valid for
a Windows Operating System.

1. Select Start.

2. Select Settings.

3. Select Control Panel.

4. Double-click Remove/Add Programs.

5. Select MCT 10 Set-up Software.

6. Select Remove.

Installation and De-install... VLT® MCT 10 Set-up Software
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4 Set-up of Communication

4.1 Communication Options

Danfoss frequency converters in the FC 100, FC 200 and FC
300 series are equipped with a USB port. Communication
from a PC can be established using a standard A – B male
to male USB cable connected to the frequency converter.
No extra hardware or bus configuration is required. If the
PC is equipped with more than one USB port, several
frequency converters can be connected. The USB bus is
automatically added to the Network bus list.

Establish a hardwired connection through

• standard built-in RS-485, or

• USB port.

The USB interface socket allows devices to be connected
and disconnected using hot swapping. Connecting a
frequency converter using USB, MCT 10 Set-up Software
automatically adds on to the bus list.

If the Profibus DP V1 MCA 101 or Ethernet/IP MCA 121
option is mounted in the frequency converter(s), establish
the connection through:

• Profibus Master Class 2 connection (MSAC 2), or

• Ethernet based network

NOTICE
The Softstarter can only be
connected through a USB cable.

NOTICE
RISK OF DAMAGE TO PC USB HOST
CONTROLLER
When connecting the PC to the frequency converter
through the USB cable, there is a risk of damaging the
PC USB host controller.

• Follow recommendations for grounding
described in the Operating Instructions for the
relevant frequency converter.

• Use a USB isolator with galvanic isolation to
protect the PC USB host controller from earth
ground potential differences, when connecting
the PC to a frequency converter through a USB
cable.

• Do NOT to use a PC power cable with a ground
plug when the PC is connected to the frequency
converter through a USB cable.

Communication from a PC can be established via RS-232
to RS-485 converters or via USB to RS-485 converters.

Illustration 4.1 Communication from a PC

4.2 Manual Fieldbus Configuration

After installation, configure the non plug-and-play
networks via the fieldbus configuration dialog.

Illustration 4.2 Windows Control Panel

Illustration 4.3 Refresh of Fieldbus List

Set-up of Communication VLT® MCT 10 Set-up Software
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1. Open Windows control panel.

2. Select Fieldbus configuration.

3. Add, remove or reconfigure the non plug-and-
play fieldbusses from the installed list.

4. If the installed fieldbus list is updated from the
Windows Control Panel while MCT 10 Set-up
Software is running, right-click Network to refresh
the fieldbus list.

5. Scan the network for active frequency converters
to make MCT 10 Set-up Software indicate
available frequency converters on the non plug-
and-play fieldbusses.

1
3
0
B
T
6
3
0
.1
0

Illustration 4.4 Fieldbus Configuration

4.3 Automatic Scan

Only the USB fieldbus is automatically scanned when a
frequency converter is connected to the PC. For non-plug-
and-play fieldbusses, perform a manual scan for active
frequency converters.

4.3.1 Scan Range Configuration

Enter the preferred scan settings by right-clicking
SerialCom and then selecting Configure Driver.

Adding a standard bus RS-485 or Profibus to the Network
tree, the scan range is configured to scan the entire
address range. The Ethernet-TSC bus is added using the
current IP address settings.

The fieldbus scan range can be configured in 3 ways:

• Right-click the Fieldbus icon in the Network tree
and select Configure Bus

• Mark the Fieldbus icon in the Network tree and
select Configure under Communication in the
main menu bar.

• Open the Fieldbus Configuration dialog, right-
clicking on the Network icon and select Add/
Remove/Configure Busses or from the Windows
Control Panel.

Illustration 4.5 Scan Network Icon

4.3.2 Scan Network

Scan a fieldbus in 3 ways:

• Right-click on the Fieldbus icon in the Network
tree and select Scan Bus for active frequency
converters.

• Mark the Fieldbus icon in the Network tree and
select Scan/Refresh under Communication in the
main menu bar.

• Mark the Fieldbus icon in the Network tree and
select the Scan icon on the toolbar.

The Scanning for Drives window pops up and indicates the
progress of the scan:

Illustration 4.6 Progress of Network Scanning

NOTICE
Using the VLT FC 100, FC 200 and FC 300 series: FC Drive
MC Protocol (8-30 "FC Drive MC) is required for correct
functionality. The parameter is only available from the
LCP.

4.4 Set up the Frequency Converter with
RS-485 Data Communication

All frequency converters can be configured to 300, 1200,
4800, 9600 (default), 19200, 38400, 57600 or 115200 baud.
The serial configuration is always configured with 8 data
bits, 1 stop bit and even parity.

Set-up of Communication VLT® MCT 10 Set-up Software
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4.4.1 Serial Bus Configuration

When using an RS-485 converter as the Advantech ADAM
converter, MCT 10 Set-up Software indicates online
frequency converter(s) available on the serial bus after
scanning the bus.

1. Open Serial fieldbus configuration dialog box or
right click the appropriate serial bus.

Illustration 4.7 Serial Fieldbus Configuration

2. Set the COM port number. When using USB to
RS-485 converters, the actual comport number
can be identified from the Device Manager part
of the Windows Control Panel.

3. Set the baud rate, parity and the number of stop
bits (must match the settings in the frequency
converter).

4. Set the fieldbus scanning range to the available
addresses to limit the time scanning for active
frequency converters.

5. Press OK to activate settings or select to restore
default settings.

NOTICE
Protocol and advanced settings are for performance
optimisation, and should normally not be changed.

4.4.2 USB Data Communication

Illustration 4.8 Network Bus List

When the USB cable is disconnected, the frequency
converter connected via the USB port is removed from the
Network bus list.

NOTICE
A USB bus has no address-setting capacity and no bus
name to configure. Connecting more than one frequency
converter through USB, the bus name will be auto
incremented in the MCT 10 Set-up Software Network bus
list.
Connecting more than one frequency converter through
a USB cable often causes computers installed with
Windows XP to throw an exception and crash. Therefore
it is advised only to connect one frequency converter via
USB to the PC.

4.5 Set-up of Softstarter

Setting up connectivity to the MCD 500 requires that the
USB communication module is mounted on the Softstarter.
Communication from a PC can be established using a
standard A – B male to male USB cable connected to the
USB communication module. If the PC is equipped with
more than one USB port or a USB HUB, several Softstarters
can be connected.

Set-up of Communication VLT® MCT 10 Set-up Software
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4.5.1 Serial Configuration

All Softstarters can be configured to 300, 1200, 4800, 9600
(default),19200, 38400, 57600 or 115200 baud. The serial
configuration is always configured with 8 data bits, 1 stop
bit and no parity.

Illustration 4.9 Serial Configuration of Softstarters

1. Add and configure the bus from the Fieldbus
Configuration dialog. If the bus is already added
to the network, it can be reconfigured by right-
clicking on the appropriate Softstarter serial bus.

2. Set the COM port number. The actual COM port
number can be identified from the Device
Manager part of the Windows Control Panel.

3. Set the baud rate, parity and the number of stop
bits (must match the settings in the Softstarter).

4. Reset to default restores the general settings and
Fieldbus scanning to factory configuration values.

4.6 Profibus DP-V1 Communication

To set up Profibus DP-V1 communication, the MCA 101
Profibus option module is required. Communication from a
PC using Profibus DP-V1 can be established using a
Profibus PCMCIA card or a card installed in the PC. The
Profibus cable from the frequency converter is connected
to the 9-pin sub D socket connector located on the card.

- V - V

- V - V

Illustration 4.10 Profibus DP-V1 Communication

Consult Siemens www.siemens.com for latest supported
cards for PCs.

NOTICE
Connectivity via Profibus DPv1 to a FC 302 utilizing the
Profibus Converter MCA 114 with option firmware
version 2.03 is not possible from MCT 10 Set-up
Software. It is advised to use the serial or USB bus.

4.6.1 Profibus DP-V1 Configuration

When using a Profibus interface card with the associated
driver installed, MCT 10 Set-up Software indicates online
frequency converter(s) available on the specific Profibus
after scanning the bus for active frequency converters.

1. Configure the bus from the Fieldbus Configuration
dialog or by right-clicking the appropriate
Profibus bus.

2. Set the Board number.

3. Set the Fieldbus scanning range to the available
addresses only to limit the time used for
scanning active frequency converters.

4. Press OK to activate or reset to restore factory
default settings.
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Illustration 4.11 Profibus Fieldbus Configuration

4.6.2 DP-V1 Connection and PG/PC
Interface

The MCT 10 Set-up Software Profibus DP-V1 fieldbus plug-
in utilises the Siemens SoftNet driver available from Step7,
or alternatively Simatic NET, to establish connectivity via
the supported Master Class 2 cards like e.g. CP5511 or
CP5512.
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NOTICE
STEP7 Lite version does not support the SoftNet driver!

The following procedure explains how to set up the PG/PC
Interface from default configuration to open the Profibus
connection from MCT 10 Set-up Software.

It is a precondition that cabling and terminations are in
accordance with wiring and cabling requirements for
Profibus.
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Illustration 4.12 Set PG/PC Interface

1. Open the PG/PC interface.

2. Configure Access Point of the Application to
CP_L2_1 pointing to the Master Class 2 card
used.

3. Set Interface Parameter Assignment Used
corresponding to the Master Class 2 card used.

4. Select Properties to configure the Station- and
Network Parameters.

• Station Parameters: Set PG/PC is the only
master on the bus to Active, if no PLC is
active on the bus. Use the Diagnostics
described later to select a valid Profibus
address.

• Network Parameters: Set the
Transmission rate to the same baud rate
as the PLC, if it is active.

5. Use DP as Profile and press OK to close the
Properties dialog.

6. Select Diagnostics in the Set PG/PC Interface to
verify network- and bus communication.
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Illustration 4.13 Properties Dialog
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Illustration 4.14 Simatic Network Diagnostics Dialog

7. Select Test to verify the Access path and Network
configuration. If a sharing violation is detected,
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the test results in an error message. When the
test result is successful, select Read to identify the
active Profibus Nodes available on the network.
Make sure the address defined for the PG/PC
interface does not conflict with an active node.

8. Close the PG/PC interface and start MCT 10 Set-
up Software. Right-click a Profibus and select
Scan for active drives. MCT 10 Set-up Software
identifies the same node IDs, except PLCs.

4.6.3 Profibus Multitelegrams

With the Parameters allowed per telegram drop-down list, it
is possible to configure the number of requests to be
associated within a multitelegram. The standard allows up
to 40 telegrams to be associated.

The following options are available

• Maximum speed (default configuration). Handles
the association automatically and adapts the
number of telegrams for each frequency
converter according to the series. Can be used in
Profibus networks containing both old and new
Danfoss VLT Drives products.

• Conservative. Always associates 10 telegrams
within a multitelegram. This option is useful
communicating only with old products such as
the FCD 300, FCM 300, FC 100, FC 200, and FC
300 all derived series.

• Single request. Only one request per telegram.

4.7 Ethernet-TSC Data Communication

To set up an Ethernet-TSC (Transparent Socket Channel)
communication, the Ethernet/IP MCA 121 option module is
required within the frequency converter. Communication
from a PC can be established using a standard Ethernet
cable connected to the frequency converter.

4.7.1 Ethernet-TSC Configuration

Ethernet-TSC bus is scanned using ADDP (Advanced Digi
Discovery Protocol). The protocol does not require an IP
Port number and IP scan range. It identifies frequency
converters based on the MAC address.

NOTICE
When scanning through different subnets or remote via
a VPN tunnel, it is advised not to utlise the ADDP
protocol, but to use an IP Range, see Illustration 4.15.

Click Scan to generate a list of all active frequency
converters in the Ethernet. The list is shown in the Drive
Discovery and Configuration dialog when scan is completed.
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Illustration 4.15 ADDP Configuration

Frequency converter types without any IP configuration
use their Auto IP Class B address, which is 169.254.yy. xx,
with yy.xx corresponding to the last two segments in the
MAC address. Several uncommissioned frequency
converters without any IP configuration can be scanned on
the same network. MCT 10 Set-up Software displays a
warning when a frequency converter with an Auto IP
address is identified prompting the user to set up the IP
configuration.

Configure is used to assign the frequency converter a static
IP address, Subnet Mask, Default Gateway or to setup using
DHCP (Dynamic Host Configuration Protocol) lookup.

4.7.1.1 Scan with IP Range

When scanning using an IP Range, the Ethernet telegrams
are transmitted as traditional TCP/IP packages routed out
in a router, switch or manage switch without requiring any
changes. The disadvantage is an increased scanning time
and frequency converters without IP address configured
are not identified.

1. Configure the IP start address, IP end address and
the Transparent Socket Channel Port
(12-89 Transparent Socket Channel Port), which is
factory default 4000 in the frequency converter.

2. Select Configure to open the Device Configuration
dialog.

3. Assign a static IP address, Subnet Mask, Default
Gateway to the frequency converter to set up
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using DHCP (Dynamic host Configuration
Protocol) lookup.

Illustration 4.16 Device Configuration

After the scan all active frequency converters are identified.
Use a corresponding offline frequency converter to read or
write to a single frequency converter instead of waiting for
MCT 10 Set-up Software to scan and identify all frequency
converters.

1. Open the project file or manually create the
offline frequency converter.

2. Configure the connection properties.

3. Right click the offline frequency converter.

4. Read and write to the frequency converter
without scanning the bus.

NOTICE
Identification of frequency converters utilising the
Ethernet/IP option MCA 121 is possible only from option
firmware version 1.03 or newer. Using options with
firmware versions earlier than 1.03, the
12-89 Transparent Socket Channel Port must be
configured to 0 to prevent the option from failing to
operate.
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Illustration 4.17 Drive Discovery and Configuration

4.7.2 Wink Drive

During a commissioning process of a system containing
several frequency converters, it can be time consuming to
physically locate a frequency converter based on the MCT
10 Set-up Software project. Especially if they are not
equipped with a LCP.

Through the Ethernet-TSC fieldbus it is possible from MCT
10 Set-up Software using a Wink function to blink with the
MS, NS1 and NS2 LEDs located on all Danfoss Ethernet
based fieldbus options.

1. Right click a frequency converter from the
Ethernet network.

2. Select Start winking or Stop winking.

On the Ethernet based fieldbus option the winking is
recognised with all 3 LEDs blinking orange with 1 Hz
interval. There is no limitation in the number of frequency
converters winking and the duration of winking.

Set-up of Communication VLT® MCT 10 Set-up Software
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Illustration 4.18 Start Winking

NOTICE
It can take up to 30 seconds from starting or
stopping the winking, until the option responds.
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5 Parameter Set-up

This chapter explains how to control a frequency converter
using the MCT 10 Set-up Software. After starting the MCT
10 Set-up Software, the main window looks like this:

Illustration 5.1 MCT 10 Set-up Software Main Window

5.1 User Interface

5.1.1 Display

The MCT 10 Set-up Software is displayed in two parts, Left View and Right View.

Left view
The Left View shows the  Network (real, online) and Project (simulated, offline) views of the frequency converter network.

Use Left View to

• Add or delete folders and elements

• Store changes into the Project folder

Store changes made to the real online set-up into the Project folder in the simulated, offline set-up for later use.

For more information on saving data, refer to .

The Left View is organised in a tree structure and contents can be expanded or compressed as required. Click +/- , to open/
close the folder.

Right view
The Right View displays details of the element highlighted in the Left View. In the Right View the elements of the frequency
converter network can be programmed.

Parameter Set-up VLT® MCT 10 Set-up Software
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Illustration 5.2

Toolbar
A toolbar displays icons for the most commonly used
functions.

Illustration 5.3 Toolbar

Activate the toolbar under View in the main menu bar
where the Toolbar is tick-marked when it is active. To
deactivate the Toolbar, select View ⇒ Toolbar. Check that
the Toolbar is no longer tick-marked.

5.1.2 Network and Project Folders

The Network folder gives access to physical devices
operating in the field. Use Network to configure the
physical frequency converters just as with the LCP. Config-
uration changes made in the Network folder are therefore
saved only in the physical device in the field. The Network
folder contains online data.

The Project folder contains offline data.

NOTICE
Changes made in the Network folder are not
automatically saved to the Project folder.

Network mode - online
The Network folder contains the frequency converter(s),
and Low Harmonic Drive(s), Active Filters and/or
softstarters online connected to the PC. Monitor and make
changes in the parameter settings exactly as if operating
on the control panel.

Data entered online are stored in the frequency converter,
Low Harmonic Drive, Active Filter or softstarter only, not
on the hard disk. For information on saving data to the
hard disk, refer to 6.7 Save Changes to a Hard Disk.

Project mode - Offline
The Project folder contains the user-defined network of
frequency converter, Low Harmonic Drive, Active Filter
and/or softstarter.

Data entered from offline is stored on the hard disk.

Use the Project folder to

• Open a project file

• Insert folders
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• Store project-related files in any format, e.g.
Word, PDF, etc.

5.1.3 Other Folders

4 folder types are available for organising a large system
into several smaller systems.

Name Purpose Icon

Folder Folder Organize
frequency converters
and/or softstarters that
are part of a machine or
of a system

File folder Organize files belonging
to a project. Any file
format can be used

Parameter
folder

Store parameter settings
temporarily or for
documentation
purposes. The folder can
contain a single
parameter, subgroup,
parameter group or the
entire parameter
database

Scope
folder

Analyze the behavior of
one or several
parameters for
diagnostic purposes by
visualising them as a
curve.

Table 5.1 Available Folder Types

Illustration 5.4

Insert any folder type in an offline project as follows

• Right-click at the project or an existing folder and
select New Folder/New File Folder. Alternatively,

• Mark the project or an existing folder and select
New Folder/New File Folder under Insert, in the
main menu bar.

5.2 Frequency Converter Set-up

Insert a frequency converter, an active filter or a softstarter
in a project folder as follows

1. Right-click at the offline location and select the
appropriate device type. Alternatively, mark the
location in offline and select Insert in the main
menu bar.

Insert a Low Harmonic Drive in a project folder as follows

1. Right-click in the offline location and select New
Drive. Alternatively, mark the location in offline
and select New Drive in the Insert menu.

2. Enter all relevant data in the New Drive dialog
and select Make LHD.

NOTICE
The Make LHD option is only available when Power Size
and Voltage ranges of the frequency converter
correspond to the supported Low Harmonic Drive.

3. Enter all Active Filter data in the New Filter dialog.
Ensure that the fieldbus address used for the
active filter is not used for other components.
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Illustration 5.5

The Low Harmonic Drive unit is visible in the Project as a
composition of the frequency converter and the Active
Filter.
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Illustration 5.6

Insert a new folder or file folder as follows:

1. Right-click the project.

Alternatively,
1a select Insert in the menu bar.

1b Select New.

1c Select Drive.

1d Select Folder or File Folder

Illustration 5.7 New Drive Window

Drive refers to the type of frequency converter. Inserting a
frequency converter opens the New Drive window, which
consists of 4 main parts

• Name

• Drive identification

• Regional settings

• Connection

All parts are mandatory to fill in.

Name Enter a unique name for the frequency converter.
Any text/number combination is allowed.

Frequency
converter
identifi-
cation

Information regarding the frequency converter
series, power size, options installed, software
version and voltage level. The different selections
are available from the drop-down menus.

Regional
settings

Configurable for International 50 Hz or North
America 60 Hz settings. These settings mainly
discriminate between hp, kW and voltage level.

Connection The fieldbus used between the PC and the
frequency converter associated with the address to
communicate. The specific fieldbus type is available
from the drop down menu.

Table 5.2 Mandatory Fields in New Drive Window

Once the new frequency converter is added in the project
folder, frequency converter data are stored in the offline
project folder and can be viewed by clicking the frequency
converter icon
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Illustration 5.8

To change stored frequency converter data, right click the
specific frequency converter icon and select Properties.

5.2.1 All Parameters Folders

A new Drive folder contains an All Parameters folder, which
comprises a series of inner folders with generic names.
There is no rename function for these folders. The generic
folders within most frequency converters are as follows:

• Operation and Display

• Load and Motor

• References and Limits

• Inputs and outputs

• Special functions
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• Serial communication

• Technical functions

The generic folders can vary according to the type of
frequency converter selected.

Illustration 5.9

The generic folders comprise parameters relevant to the
frequency converter type selected.

Illustration 5.10

5.2.2 Array Parameters 

Parameters containing array data are displayed as a matrix in the Right View, where the rows of the matrix are identified as
ID.1, ID.2, etc. For example, array parameters 9-15 PCD Write Configuration and 9-16 PCD Read Configurationare displayed
over several entries as 915.1, 915.2, 915.3, and 916.1, 916.2, 916.3,. in the Right View, see Illustration 5.11.

Illustration 5.11
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5.2.3 Sorting

The Danfoss products listed in Network or Project can be sorted according to

• Folder name

• Series

• Software Version

• Address (communication address)

• Power Size

• Voltage
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Illustration 5.12 Sorting Options

Click the sorting bar and select the relevant sorting option.
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5.3 Customised Views

Select View in the main menu bar to see display options. The following options are available:

• Display Toolbar and Status bar

• Hide Toolbar and Status bar

• Large icons/Small icons view

• Right View as List of folders and elements

• Right View with Details of Network and Project elements

Illustration 5.13 The View Menu

Customise Parameter View Settings
Apply the selected parameter view settings to subfolders, to an entire project, or to the entire application, i.e. all MCT 10
Set-up Software folders in Network or Project mode.

1. Right-click the parameter cell or set-up column.

2. Select Apply Parameter View Settings.
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Illustration 5.14

3. Select the relevant option and click OK
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5.3.1 Customise Background Colour

To customise the background colour of the views, go to Options ⇒ Online Parameter Grid Settings
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Illustration 5.15

1. Select Restore Default to restore factory default background colour for online environment.

2. Click […] to open a standard true color picker.

3. Select Add to Custom Colors for customising colours for later usage.

5.3.2 Customise Parameter View

The parameters displayed in the Right View are presented in a series of columns, containing ID, parameter name, 4 set-ups,
units and factory set-up.

Each set-up can be hidden by selecting Parameter view ⇒ Set-up ⇒ Remove Menu.

NOTICE
Changes made to the removed set-up are still stored inside the MCT 10 Set-up Software and can be shown by selecting
Customize Columns.

Add or remove columns to customise view.

Illustration 5.16
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The actual view can be applied to the complete project or to the folder only.
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Illustration 5.17 Apply Parameter View Settings
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5.3.3 Parameter Filter Options

The parameters in the Right View can be filtered.

Setting Description

Read only Only Read-Only parameters are displayed

Read & Write Only Read & Write parameters are displayed

Changed parameters Only parameters that have been changed in the current session are displayed

All All parameter groups are displayed

Group One or more parameter groups are displayed according to selection

Table 5.3 Available Filter Settings

1. Right-click any column in Right View.

2. Select the appropriate filtering setting or the appropriate filtering group(s).

Illustration 5.18
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5.3.4 Customise Columns

To rearrange the display of columns in the Right View

1. Right-click any column title.

2. Selecting Customize Columns.

Illustration 5.19

To change the order of fields in the display

1. Highlight a field.

2. Select Move Up, Move Down or Remove.

Illustration 5.20 Change Order of Fields
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Removed columns are still stored in the memory and can
be retrieved into the Right View by highlighting the
relevant field name and selecting Add.

5.4 Parameter Edit

The parameter structures in the MCT 10 Set-up Software
and in the frequency converter are the same. Modify the
parameter by double-clicking the relevant parameter entry.
If an entry cell is shaded in light grey it is read only, and
cannot be modified.

Illustration 5.21

Change parameter set-up by manually entering new
value(s) in the cells in the Right View.
Alternatively, change the parameter set-up by importing
values from an active frequency converter, using the Read
From Drive function.

If a parameter value is set to an illegal value, an error is
displayed. Parameters can be edited in two different
modes, dialog-based and inline.

Illustration 5.22 Edit Parameter View

Inline Edit
In inline edit mode, the available setting options are
displayed without any detailed descriptions of the options.
Inline edit is only recommended for the experienced user.

Dialog Based Edit
To have details of parameters available whilst editing, use
Dialog Based Edit. Parameter options, ranges and functions.
Enter Dialog Based Edit by deselecting Inline Edit.

5.5 Comparison of Parameters

Parameter settings can be compared to the parameter
settings in another frequency converter. Comparisons can
be made either to another frequency converter inside the
project or to an online frequency converter. The
comparison function evaluates whether settings inside the
frequency converter have been changed, or checks if 2 or
more frequency converters have the same settings.

1. Activate the function by highlighting the desired
frequency converter and selecting Compare.
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Illustration 5.23 Comparison

2. Select the frequency converter for comparison.

This can be an online frequency converter from the
network, or it can be a frequency converter in the offline
folder (Project folder).

The result of a comparison can be stored in an ASCII text
file for documentation or for subsequent import into a
spreadsheet.

It is possible to compare all set-ups, or to compare one
set-up to another.

Illustration 5.24 Comparison Result

5.6 View Changelog

When configuring a frequency converter, Active Filter or
Softstarter from the project, it is possible to view the
change-log containing the changes made by the user only
or the changes made including the dependant parameters.

User-defined changes can be read out by right-clicking All
Parameters and selecting Minimal changeset.
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Illustration 5.25 Minimal Changeset

Changes made including the dependant parameters can
be read out by right-clicking All Parameters and selecting
Compare parameters with default values.
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Illustration 5.26 Compare Parameters with Default Values
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5.7 Read Drive Operation Status

The frequency converter can be in 2 different operations
conditions Auto On or Off, which can be monitored via the
LCP or MCT 10 Set-up Software. With MCT 10 Set-up
Software, monitor the actual operation status by clicking
on a frequency converter located in the network. Select
Refresh status to update the status information. Parameters
can only be written to frequency converters in operation
status Off.
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6 Operation

6.1 Reading and Writing Parameters

Parameter settings can be read from or written to an
online connected frequency converter.

The majority of parameters are read/write, and can thus be
configured. Other paramters are read only and cannot be
configured. View which parameters are read/write or read
only in the Filter function.

Select the value(s) to be read/written and then selecting
the Read From drive or Write to drive menu.

Following options are available

• A single parameter in the Right View

• All parameters in the Left View

• A group of parameters in the Left View, e.g. Load
and Motor group

and the Read from drive and Write to drive functions applies
to the whole selection.

Select Options in the menu bar to access a range of
functions.

Illustration 6.1 Select Options

6.1.1 Read From Drive Settings

Select the desired options for reading from an active
frequency converter.

Include factory set-up
If this option is selected, the factory set-up data (i.e.
default values) are included in the data read from the
frequency converter. As the factory set-up can be changed,
this option is useful for checking the actual default values.

Set-ups
Select to read visible set-ups only, or to read all set-ups.

Compatibility errors
Specify acceptable level of compatibility errors, if field
device software and MCT 10 Set-up Software versions are
not identical. Select Ignore All Errors to ignore all compati-
bility errors.
Select Ignore Drive Major Version Errors to restrict the
acceptable compatibility errors to those occurring in a
major software version. Minor version differences such as
v3.1 to v3.4 are ignored, but major version differences such
as v3.1 to v4.1 are not accepted.

Save as default settings
Activate the Read from Drive-settings for all reads from
frequency converter.

Illustration 6.2 Save as Default Settings
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6.1.2 Write to Drive Settings

Select the desired options for writing to an active
frequency converter, which then becomes applicable for all
writing to frequency converter(s).

Illustration 6.3 Write all Parameters

6.1.3 Communication Fault Tolerance

Set an acceptable number of communication faults before
breaking off the connection. The default Number of
Failures value is 0 or 1, which in practice is usually too low

a fault tolerance for smooth communications, i.e. the
connection will constantly be cut off.

For normal operating conditions, set Number of Failures to
3 to achieve reasonably smooth communications. For
operating conditions where the electrical noise level is
high, or where the standard of the installation is low, set
Number of Failures to 5.

Illustration 6.4 Fault Tolerance

6.2 Connection Properties

To read or write between on- and offline frequency
converter(s), the connection properties must be configured
in the offline project. If the fieldbus does not refer to an
available frequency converter in the Network tree, MCT 10
is not be able to identify the online frequency converter.

Reconfigure the fieldbus by right-clicking the offline
project and select Properties ⇒ Connection.

Configure the fieldbusses added to the network tree in the
Fieldbus drop-down list.

6.3 Read From Drive

‘Values can be read from an active frequency converter by right-clicking on the desired selection (in this example a
parameter column title in the Right View), then selecting Read from drive.

Illustration 6.5 Read from Drive
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Once Read from drive is selected, the software accesses the
online device and displays the Drive Check window,
showing the compatibility of the properties of the offline
project drive (where the properties are based on database
information) with the online device, i.e. Connected Drive,
as in Illustration 6.6:

Illustration 6.6 Drive Check

The colour codes indicate the level of compatibility
between the project drive and the connected drive, for
each property.

Option Description

Cancel Stops the Read From Drive-process, for example if
the level of compatibility between project drive
and connected drive is unacceptably low.

Continue Activates the Read From Drive process to show the
properties of the connected frequency converter

Update drive
from
connected

Activates the Read From Drive process, deleting
the data in the project drive and replacing it with
the data from the connected drive

Table 6.1 Drive Check Options

NOTICE
The Update drive from connected selection causes all
information stored in the project drive to be deleted and
replaced. To retain the information entered into the
project drive, select Continue.

Once the Read From Drive process is completed, the
display shows details of both the Connected Drive
Information and the Database Information.

Illustration 6.7 
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6.4 Write to Drive

Write values to an active frequency converter by right-clicking a parameter column title in the Right View and then
selecting Write To Drive.

Illustration 6.8 Write to Drive

Alternatively, access Read From Drive and Write To Drive by
selecting Communication in the main menu.

6.5 Poll

When in Network mode, MCT 10 Set-up Software automat-
ically polls the parameters in the Right View to
continuously update their status to reflect live operation.

To stop polling, for example to freeze and analyse a
particular moment:

• Select Stop Polling under Communication in the
main menu bar

or

• Select Stop Polling from the toolbar
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Illustration 6.9 Stop Polling Icon

Resume polling in 2 ways:

• Select Resume Polling under Communication in
the main menu bar

or

• Select Resume Polling from the toolbar
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Illustration 6.10 Resume Polling Icon

6.6 Changing the Set-up of a Device in the
Field

To change settings for a field device, open the Network
folder and select the relevant device.

Select stop on the toolbar to stop polling and change the
settings in the set-up columns in the Right View.

NOTICE
The changes are implemented online in the field
device, but are not recorded elsewhere.
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6.7 Save Changes to a Hard Disk

6.7.1 Record Online Changes

To record online changes to a hard disk, select the relevant device in the Network folder. Right-click the device and select
Copy.
Select the Project folder, right-click and select Paste.
Then select File from the main menu bar, and select Save As.
Save the device file into a directory in the storage location.

6.7.1.1 Save a Project

Save a project by selecting File ⇒ Save from the main menu bar. Alternatively, select the Save icon on the toolbar.

Include drive Information
It is not possible to open a project file including a firmware version not supported by MCT 10. Including the frequency
converter information in the project file, makes it possible to open in other MCT 10 installations without having the
firmware installed. Opening the project file, the frequency converter information is updated similarly to:

• Selecting Update Drive Support under Tools in the main menu bar.

• Downloading the frequency converter information from an online frequency converter.

The frequency converter information is saved in the project file. To exclude the frequency converter information in the
project file

1. Select Options.

2. Select Project properties.

3. Click to enable Project-related Files

Illustration 6.11 Save Frequency Converter Information
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6.7.2 Archive/Unarchive 

Projects that include links to other documents, can store the linked files.
By selecting the Archive function, the MCT 10 Set-up Software generates a file that contains all frequency converters and the
linked files into a *.ssa File. If this file is sent to other computers, the user gets a copy of the linked files on his computer.

6.8 Import of Older Dialog Files

For users working with VLT set-up software dialog, the files generated with these software packages can be imported into
the MCT 10 Set-up Software.
Files from DOS versions as well as Windows versions can be imported to the MCT 10 Set-up Software. Following a successful
import, the MCT 10 Set-up Software places the imported files in an imported files folder.

Illustration 6.12 Import Older Dialogs

Due to limitations in some of the former PC tools, some functionalities cannot be imported, e.g. functions such as displaying
changed values only.
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6.9 Printing

There are 2 options for printing from MCT 10 Set-up
Software:

• Print Project

• Print Selected Folders.

Both options are located under File in the main menu bar.
Alternatively, Print Project can be selected by right-clicking
the Project icon. Select Print Selected Folders by right-
clicking the icon for a folder within the project.

Select Print Project to print parameter settings for an entire
project.
Select Print Selected Folders to print parameter settings for
part of a project.

The following dialog box pops up:

Illustration 6.13 Print Options

Select the desired print language from drop-down list.

Changed Parameters
Select this option to print all parameters, or to print
changed parameters. Select between parameters

• Changed from default

• Change from factory default

• All parameters

Options
Specify which set-up to print.

Groups
Select Groups to print selected parameter groups only.

Illustration 6.14 Print Changed Parameters

1. Select the parameter groups to print.

2. Select Groups to return to the original
unexpanded Print dialog box.

3. Select OK to print.

6.10 Update Database Information

If the MCT 10 Set-up Software database information is
outdated, updates are available either by download from
Internet or when this is not possible, by reading from the
frequency converter itself.

When the MCT 10 Set-up Software database for a
frequency converter is outdated, the frequency converter
icon is displayed with a red line through it and the
Database Information cells displays the message Not
supported, as shown:
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Illustration 6.15 Outdated Software Database
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The database can be updated either by right-clicking the
frequency converter icon and selecting Download Drive
Info, or by clicking Download Drive Info.
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Illustration 6.16 Database Update

To commence reading from the frequency converter, select
Yes.

When reading from the frequency converter is complete,
the frequency converter icon no longer has a red line
through it, and the Database Information in the Right View
displays settings identical to the Connected Drive
Information.

In addition, the parameter settings are displayed in capital
letters.

6.11 Update Drives Firmware Support in MCT 10 Set-up Software

MCT 10 Set-up Software can be updated, regardless of the firmware version of frequency converter.

Download upgrades from the Danfoss web-site www.vlt-software.com and store on local disk drive.

Illustration 6.17 Update MCT 10 Set-up Software

NOTICE
The update files can be installed without administrator rights in Microsoft operating systems.
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6.12 Software Compatibility

MCT 10 Set-up Software project files can open legacy version project files. Table 6.2 shows an example

Software versions of MCT 10
Set-up Software and
frequency converter in
existing project file

Software versions
of MCT 10 Set-up
Software

Compatible

✓/✗

2.00 and 2.01 2.02 ✓
2.02 and 2.51 2.00 ✗

Table 6.2 Opening Legacy Versions

When MCT 10 Set-up Software has been updated, project-files saved as with newer version firmware can be opened and
used. This scenario is shown in Illustration 6.18.

Illustration 6.18 Use updated MCT 10 Set-up Software

To establish connectivity to a frequency converter with
firmware version 1.10, it is required to modify the MCT 10
Set-up Software drive database mapping to firmware
version 1.05 as reference.

• Start the MS Explore and open the path C:
\Program Files\Common Files\Danfoss Drives
\SharedSource\

• Open the text file ss_version_mapping.txt in
Notepad by right-clicking the file and selecting
Edit.

• Change
"Series="FC-202",AOC="01.10",Database="01.10" to
Series="FC-202",AOC="01.10",Database="01.03"

• Save and close the file

How to find out if MCT 10 Set-up Software has been
updated
The About box shows the actual MCT 10 Set-up Software
version.

NOTICE
System information can be copied
directly to the Windows Clipboard.
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Illustration 6.19 Copy System Information

6.13 Conversion Wizard

6.13.1 Match

It is required that database versions, power size, voltage
range and option configuration of the source match
destination frequency converter. Differences can be
converted using one of the conversion wizards available in
MCT 10 Set-up Software:

• VLT to FC series conversion

• FC to FC series conversion

NOTICE
If the parameter database of a source frequency
converter is different from the database on the
destination frequency converter, it cannot be written
without errors signalled during write to drive.

6.13.2 VLT to FC Series Converter Function

It is possible to convert e.g. a VLT 5000 frequency
converter to an FC 302 with the conversion matrix in the
MCT 10 Set-up Software.

Illustration 6.20 Conversion
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Conversion of multiple frequency converters

1. Select the Tools menu and activate Drive
Conversion Wizard.

2. In the following dialogs select the frequency
converters for conversion.

3. When converted, a new FC 302 frequency
converter is created in the project folder.

Illustration 6.21 Conversion of Multiple Frequency Converters

6.13.2.1 Import Drive from Excel

Use this function to create an FC30x frequency converter
project based on an Excel sheet. Import of e.g. VLT 3000
settings from an excel sheet into a new FC 302.

An example file is attached in MCT 10 Set-up Software
(vlt3000conversion.xls), this example file can be edited and
used for converting from VLT 3000 to FC 302.

NOTICE
Detailed knowledge of Microsoft Excel
formula editing is required.
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6.13.3 FC to FC Series Conversion

The converter tool can convert projects within the same frequency converter series, regardless of software versions, power
size, voltage range and option configuration. It covers FC 102, FC 202, FC 3xx, LD 302 and all OEM versions based on the FC
xxx series. Differences can be matched by using the Conversion Table Manager.
A conversion table enables conversion from

• Online to Online Drive

• Online to Offline Drive

• Offline to Online Drive

• Offline to Offline Drive

2 user profiles are available:

• Administrator – qualifies and manages the conversion table(s) through access to the Conversion Table Manager.
From the Conversion Table Manager, new conversion table(s) can be created and deployed to other MCT 10 Set-up
Software installations.

• User – writes projects to the destination, using the conversion tables transparently. The user cannot access the
Conversion Table Manager. Conversion tables can be imported to the database.

MCT 10 Set-up Software is installed with user rights. Enabling the Conversion Table Manager is done from the checkbox in
the Converter Tools Settings dialog.

Illustration 6.22 Enabling Conversion Table Manager

The conversion tables are stored locally on the hard disk. Using the database non distributed, the path to the network
location can be reconfigured from the Converter Tool Settings dialog.

Operation VLT® MCT 10 Set-up Software

44 MG10RA02 - VLT® is a registred Danfoss trademark

66



6.13.4 Conversion Table Manager

Access the Conversion Table Manager through the MCT 10
Set-up Software tools menu.

Illustration 6.23 Conversion Table Manager

The dialog is divided in a Conversion Table containing the
list of conversion tables in the database and a Preview
pane. Conversion tables can be created or imported,
edited, exported or deleted.

Exporting tables
Distribute to other MCT 10 Set-up Software installations by
exporting the relevant tables to a *.cvt file. The Preview
pane lists the conversion table source and destination
frequency converter information. The conversion can be as
follows:

• Drive series based on the FC 102/FC 202/FC 3xx
platform

• Software version (major and minor)

• Power size

• Voltage range

• Option A

• Option B

• Option C0

• Option C1

Create new conversion tables
To create a new conversion table, open the Conversion
Table Manager or right-click the source drive and select
Convert drive.

NOTICE
When using the right-click option, it is only possible to
configure the information of the destination frequency
converter. Furthermore, parameter group 19-** User-
defined Parameters is not converted. These settings are
configured when writing from source to destination.

Illustration 6.24 Drive Conversion

Editing Tables
Source and Destination frequency converter info defined,
opens the conversion table editor listing the parameter
database differences.

Use the Conversion Table Editor to create or load a
conversion table. Ensure that the conversion table matches
the drive series, software version, power size, voltage
range and option configuration. The MCT 10 Set-up
Software is not able to find and load incompatible
conversion tables. After loading or creating the conversion
table, it is possbile to reedit the table or to convert the
source frequency converter and store the converted
frequency converter in an offline folder.

Formulas
The parameter database is listed and sorted according to
the parameter ID. To simplify conversion process, filter the
database to list alerts or applied changes only.

Colour
Code

Description

Red Difference between source database and frequency
converter. A formula is required before changes can be
applied to the frequency converter (???)

Blue Difference between source database and frequency
converter. The formula is ignored and changes can be
applied to the frequency converter (???).

Table 6.3 Alert Colour Coding
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NOTICE
If a formula is applied to all alerts, the source parameter
database can be converted to the destination parameter
database without any further configuration.

Illustration 6.25 Conversion Table

Double-click an alert to open the Formula Editor dialog and specify the destination parameter mapping. The following
configurations are possible:

• Destination parameter is set to default value (factory default value. Default setting for red alerts

• Destination parameter = source parameter ID

• Destination parameter = source parameter multiplied by a user defined numeric value
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• Destination parameter = destination choice list or numerical value

• Ignore this parameter. Default setting for blue alerts

Each formula applied can be associated with a comment containing a user-defined text. The comment is optional to each
alert.

Illustration 6.26 Formula Editor

When a formula is applied to all red alerts, assign a name to save the conversion table in the database.

If differences are detected when writing from source to destination frequency converter, MCT 10 Set-up Software uses the
frequency converter series, major software version, power size, voltage range and option configuration as search criterias.
With the proper conversion table in the database, any frequency converter can be written transparently to a destination
even, if the minor software version does not match. If several conversion tables are found matching the criterias, MCT 10
Set-up Software uses the minor software version to find the closest match. Only one frequency converter can be written to
destination transparently.

If parameter group 19-** User-defined Parameters is available, the settings are written to the destination frequency converter.
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6.13.4.1 Convert Offline to Offline/Online to Online

Write between 2 offline or 2 online frequency converters is done as follows:

1. Mark the appropriate number of set-ups from All Parameters.

2. Right-click and select Copy.

3. Paste the parameters in the destination frequency converter folder.

Illustration 6.27 Offline Online Conversion

MCT 10 Set-up Software recognises any difference and
automatically applies a matching conversion table, if
available.
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6.13.4.2 Convert Online to Offline/Offline to Online

NOTICE
Before converting, ensure that offline and online frequency converter connection properties correspond.

Write from online to an offline frequency converter by right-clicking the offline frequency converter and selecting to read
from frequency converter. MCT 10 Set-up Software recognises any difference and automatically applies a matching
conversion table.

Illustration 6.28 Offline Online Conversion

NOTICE
Make sure the offline frequency converter connection properties corresponds with the online frequency converter.
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7 Diagnostics

7.1 Alarm, Warning and Fault Log Readout

Features from Version 2.0, MCT 10 Set-up Software
supports the feature of

• Reading out alarms, warnings and fault logs of
the online frequency converters

• Quick locatation of alarms and warnings in the
connected drive system

• Investigation of the fault log for previous trips

• Gathering and storing events in the project file
for later evaluation

• Sending the project file to a remote specialist for
further investigation

7.2 Localisation of Alarms and Warning

After a complete scanning of a drive network, the MCT 10
Set-up Software indicates, if the connected frequency
converters have active warnings or alarms. Both warnings
and alarms are indicated by a “!” in front of the drive icon.

Illustration 7.1 Frequency Converter with Active Alarm or
Warning

Expand the frequency converter and click the alarm/
warning icon.

Name Icon

Active
alarms/
warnings

No active
alarms/
warning
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Illustration 7.2 Alarms, Warnings and Fault Log View

Ite
m
No.

Description Item
No.

Description

1 The date when information was read from the frequency
converter

4 Warning/alarm code

2 The time when information was read from the frequency
converter

5 Name of warning/alarm

3 The number of operating hours   

Table 7.1 Legend to Illustration 7.2

For a more detailed description of the code, refer to the Operating Instructions for the particular frequency converter.
If the frequency converter trips, it stores the cause for the trip in a fault log buffer. The log consist of 3 values;

• code

• value

• time

When MCT 10 Set-up Software reads the fault log, it displays the time and date when the log was read.

NOTICE
The actual time of when a fault occurs is not indicated.
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7.3 Storing Alarms/Warnings in Project Files 

Before alarms/warnings and the fault loggings are stored into the Project File, enable the function in MCT 10 Set-up
Software. Select Options ⇒ Update Alarms & Warnings. The MCT 10 Set-up Software now automatically reads alarms,
warnings and fault loggings at every read from/write to the frequency converter.

Illustration 7.3 Update Alarms & Warnings

7.4 Handling the Alarms and Warning
Loggings

MCT 10 Set-up Software allows for more than 200 alarms
and warnings for each frequency converter in the project.
The loggings can be individual cleared. This is done by
entering the loggings to clear, and right-click. Clearing the
log only clears the PC log, while the information in the
frequency converter is unaffected by this handling.

NOTICE
Redundant alarm entries in log.

The MCT 10 Set-up Software stores active alarms and
warnings in the project file at each read/write command.
No alarm is lost, but an alarm can have multiple entries in
the log.

Illustration 7.4 Loggings
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7.5 Scope Function

The scope function supports monitoring and diagnosing of
parameters. The function polls parameter data and
dynamically displays the polled data as a curve graph.

The scope function provides 2 different channel types to
sample parameters:

• PC Polling Channel – channel selected when the
PC-SW requests the parameters from the
frequency converter. The channel does not have
any time limitation, the buffer size is user config-
urable and corresponds to the number of
samples. Fast sampling with accurate sampling
rate cannot be obtained because the Windows
operating system does not support real-time
extension.

• Drive Real Time Channel – only available in the
FC 102, FC 202, and FC 300 series - uses an
internal 16 kByte buffer located in the frequency
converter. Recommended for continuously
monitored applications requiring high and precise
sampling rates. It is required to set up a trigger
event for the frequency converter to start filling
up the buffer with samples.

7.5.1 Activating the Scope - MCT 10 Set-up
Software

Insert a new scope from the Insert menu or by right-
clicking the Project Folder, Drive Folder, regular folder or
Drive.

Illustration 7.5 New Scope

Rename the scope folder via the Edit menu or by right-
clicking the icon and select Rename.

The first time Scope folder is selected, the Add Channel
dialog pops up. From this dialog, select the frequency
converter to monitor. Then, depending on the frequency
converter series, select the type of channel to collect
samples from.
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Illustration 7.6 Add Channel

Adding text notes
Insert additional text for later usage to each scope folder
such as the type of frequency converter monitored,
diagnostic help text, etc. Text notes are added by right-
clicking the Scope folder and selecting New ⇒ Text Note.
The default text can be changed by right-clicking the text
note and selecting Rename. Several text notes can be
added to the same scope folder.
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Illustration 7.7 Text Notes
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7.5.2 Configure the PC Polling Channel

PC Polling Channel is default enabled when a frequency
converter is selected within the Network- or Project folder.
All parameters available in the list are visible by ID and
Name, and are automatically updated according to the
product.
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Illustration 7.8 Parameter ID and Name

1. Select a parameter in the Parameter list and press
Next to update the Add Channel dialog.

2. Configure A/div (value/division).

NOTICE
MCT 10 Set-up Software stores the values, even if they
are not displayed within the visible area of the curve.
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Illustration 7.9 Storring Values

3. Define the position number (Vertical Zero line on the Y Axis). If there are several signals on top of each other, it is
useful to have them plotted apart.

4. Set colour and checkmark Marker to differentiate the different curves in a black and white printout. Each curve
gets a marker as box, triangle, cross etc.

5. Click OK to generate the curve graph.
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Illustration 7.10 Generate Curve Graph

Right-click the channel box to open the Add Channel
dialog and add additional channels.

Illustration 7.11 Open Add Channel Dialog

7.5.3 PC Polling Channel Properties

Additional settings can be configured by right-clicking the
Scope window, and selecting Properties. It is possible to
specify

• general parameter sample settings

• sample trigger settings

• cursor settings

General parameter sample settings
The General tab holds 4 basic settings for the Scope
Properties:

1. Seconds per division (SEC/DIV)

2. Time Format

3. Buffer Size in samples

4. Polling Rate in milliseconds
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Illustration 7.12 Scope Properties - General Tab

Description Format Value range

SEC/DIV Time base on the X-axis 0.0001 s to
1.000.000.000 s

Time Format Year, month, date, hour,
seconds and milliseconds

-

Buffer Size Number of data sets in the
buffer

0 to 1.000.000

Polling Rate Time in milliseconds
between two samples

 

Table 7.2 Basic Scope Settings

NOTICE
For systems with large inertia, a low sampling rate may
be used since the value changes slowly. For systems with
low inertia, a high sampling rate is needed.

NOTICE
Setting Polling Rate to As fast as possible means that MCT
10 Set-up Software does not control the actual time
between each sample. This can lead to a high jitter
between two samples.

Trigger
The trigger function starts the sampling of values only
when a certain value is reached. This reduces the need for
large buffer sizes. A trigger is also a valuable tool to see if
values cross border where the frequency converter does
not store any warnings.

Illustration 7.13 Scope Properties - Trigger Tab

Trigger
functions

Description

Source Source channel

Level Level where the Trigger has to be activated

Mode Auto starts the trigger automatically when Resume
All is pressed. The trigger line is set to the time
when Resume was pressed. Normal (Norm)
activates the trigger when level and slope settings
are fulfilled.

Scope Sets if the value has to be rising (source value
goes from low values to higher values) or the
slope has to be falling (source value goes from
high values to low values).

Table 7.3 Description of Trigger Functions

Cursor
Style defines the functionality of the cursor. The style
contains 5 different possibilities:

• Value XY - shows the time and value of each
signal at the cursor location.

• Value X – shows the time alone.

• Value Y – shows the value alone.

• Delta X - shows two cursors, and the time
between the two cursors are calculated.

• Delta Y – works like Delta X, but this time the
difference between two levels is calculated.

Pointer Position defines the default position when a cursor
is inserted in Scope.
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7.5.4 Reuse of PC Polling Channel Settings

Often the same settings are used when measuring with
the PC Polling Channel on more than one frequency
converter. These settings can be reused either by copying
an existing scope folder or by reusing an existing one.

The scope folder connection properties can be
reconfigured for another frequency converter in the
network by double-clicking an added channel. In the
Reconfigure Channel dialog, another frequency converter
located on the same or a different fieldbus can be
selected.
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Illustration 7.14 Reconfigure Channel

7.5.5 Configure the Drive Real Time
Channel

Drive Real Time Channel can be selected if the functionality
is supported in the frequency converter selected in the
network.

1. Select the relevant frequency converter.

1a Drive Real Time Channel opens the Scope
Properties dialog.

2. Configure the channels depending on what the
actual frequency converter supports.
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Illustration 7.15 Select Driv Real Time Channel

All available parameters are listed by parameter name.

3. Configure the sample rate for each channel using
the time format HH:MM:SS:zzz.

4. Configure sampling mode through the Trigger
Event, Logging Mode and Samples Before Trigger
options.
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Illustration 7.16 Configure Sampling Mode

7.5.6 Using Advanced Triggers 

NOTICE
The Real Time Channel Trigger Event utilises the event
available from the Smart Logic Controller.

Example
The following example explains the set-up of a trigger,
which triggers the collection of data in the frequency
converter when the motor speed exceeds a certain limit
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Set up a comparator in the Smart Logic Control to get a
trigger signal when the motor speed exceeds a certain
limit:

1. Select the Smart Logic group

2. Select a comparator not in use, 1310.0, and set it
up to motor speed

3. Set Comparator Operator 1311.0 to greater than
>.

4. Set Comparator Value 1312.0 to the needed value.

5. Set up the trigger event in the Drive Real Time
Channel Properties dialog to Comparator 0, and
set the Logging mode to log once on trigger.

Press OK to enable the set-up.

Illustration 7.17 Smart Logic View
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Illustration 7.18 Trigger Event

To start MCT 10 logging, press Start (resume) Poll which
opens the dialog to define the Real Time log style.

Illustration 7.19 Real Time Log Style

7.5.7 Drive Real Time Channel Properties

Additional settings can be configured by right-clicking the
Scope window, and selecting Properties.

It is possible to reconfigure all Drive Real Time Channel
settings and additionally to configure:

• SEC/DIV and Time Format

• Appearance settings

• Cursor settings
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Illustration 7.20 Reconfigure Drive Real Time Channel Settings

Besides being able to reconfigure the settings made from
the Drive Real Time Channel Properties dialog, SEC/DIV and
the Time Format are configurable.
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SEC/DIV
The  SEC/DIV and Time Format functionalities are similar to
the PC Polling channel functionality, see 7.5.2 Configure the
PC Polling Channel.

Appearance
Each channel name can be renamed.

The Units/Div, Position, Marker and Color functionalities are
similar to the PC Polling channel functionality.

Cursor
The functionality is similar to the PC Polling Channel
functionality.

7.5.8 Communication Control

The Scope toolbar has 4 main buttons to control the
communication.

Control Button  Function

Start (Data
Acquisition)

MCT 10 Set-up Software Scope
starts collecting the requested
data from the frequency
converter Network.

Stop (Data
Acquisition)

MCT 10 Set-up Software stops
collecting data and there is no
communication to the frequency
converter network while the
Scope part is active on the
screen.

Start (resume) all
tracking

Activates the tracking
mechanism. MCT 10 Set-up
Software starts the readout of
variables to the screen and to
the buffer. Variables are checked
up against the trigger settings.
If the buffer has been partially
filled (use of the Pause All
Tracking function), MCT 10 Set-
up Software continues to fill
data into the buffer.

Pause All Tracking Deactivates the tracking. Buffer
remains at its current state, no
new data are displayed. The
buffer-pointer keeps its current
position.

Table 7.4

7.5.9 Additional Functionality

Select Resume Poll to start tracking. To stop tracking press
Stop Poll or Pause All Tracking. The tracking continues until
the buffer is filled (default 1000 samples). If the tracking
stops due to a filled buffer, the buffer has to be emptied
before a new track can be activated. Clear the buffer and
reset the scope in one step by clicking

Illustration 7.21 Clear all Buffer for the Channel

Alternatively, the buffer can be cleared individually.

Illustration 7.22 Individually Clear the Buffer

Name Description Icon

Reset Scope Clears all buffers for the
channel at once. This is
more convenient if many
channels are activated at the
same time, or if a new
channel is added to an
existing track. Before new
values can be added to a
track, all channel buffers
must be emptied, since MCT
10 Set-up Software requires
that all buffers have the
same amount of data.

Export to
Excel

Export to Excel enables
storing scope data in a file
which Microsoft Excel can
open. A Save file dialog
appears, making it possible
to store the file in an
appropriate location.
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8 Smart Logic Controller Plug-in

From Version 2.13, MCT 10 Set-up Software supports the
Smart Logic Controller Plug-in. This feature enables quick
set-up of logical sequence programs.

The Smart Logic Controller monitors a pre-determined
event. When the specified event occurs, it performs a pre-
determined act and starts monitoring the next
predetermined event – and continues that way in up to 20
different steps until it returns to step 1 – monitoring the
first specified event.

The logic controller can monitor any parameter that can
be characterised as “true” or “false”. This includes digital
commands and logic expressions, which allows sensor
outputs to determine the operation. Temperature,
pressure, flow, time, load, frequency, voltage and other
parameters combined with the operators “>”, “<”, “=”,
“and” and “or” forms logic expressions that controls the
frequency converter logically in any application.

Refer to the relevant Design Guide for a full overview of the
Smart Logic Controller features.
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9 Time-based Actions and Preventive Maintenance Plug-ins

For the VLT® HVAC Drive FC 102, the MCT 10 Set-up
Software provides the following plug-ins:

• Clock features

• Preventive maintenance

• Time-based actions

NOTICE
Consult the relevant Design Guide for detailed
information about the frequency converters.

9.1 Clock Functions

MCT 10 Set-up Software enables set-up of the clock
features

The clock features are grouped in 2 sub-levels:

• Date and Time

• Working days

9.1.1 Date and Time

In the Date and Time dialog, the following groups of
settings are available:

• Display format

• Set date and time

• Daylight saving time

• Enable clock fault

Display format in LCP
Select how date and time are presented in the LCP on the
FC 10x. In MCT 10 Set-up Software parameters, Date and
Time format depends on PC Regional Options (Date and
Time format).

Set Date and Time
Change the date and time in the FC 10x from the PC.
Normally, it should be set to use the connected PC’s date
and time. When the connected PC’s time is in another time
zone, it is beneficial to set the date and time manually.
Date and time are changed in MCT 10 Set-up Software
project file or in the drive only when Change check-box is
checked.

Daylight Saving Time
Set the date and time for daylight saving.

Daylight Saving Time begins for most of the United States
at 2:00 a.m. on the first Sunday of April. Time reverts to
standard time at 2:00 a.m. on the last Sunday of October.
In the U.S., each time zone switches at a different time. In
the European Union, Summer Time begins and ends at
1:00 a.m. Universal Time (Greenwich Mean Time). It begins
the last Sunday in March and ends the last Sunday in
October. In the EU, all time zones change at the same
moment.

Enable Clock Fault
If the clock is not set up, the frequency converter shows a
specific warning. Enable or disable the Clock Fault function.

9.1.2 Working Days

Define the working days for time based actions as follows:

1. Select First day of the week (Monday or Sunday).

2. Select working days and non-working days.

3. Set additional working days (max 5).

4. Set additional non-working days (max 15).

Illustration 9.1 Define Working Days

NOTICE
Additional working dates and non-working dates
have year and must be updated every year.

Time-based Actions and Prev... VLT® MCT 10 Set-up Software

MG10RA02 - VLT® is a registred Danfoss trademark 61

9 9



9.2 Preventive Maintenance

The preventive maintenance feature supports the planning of periodic maintenance of both the frequency converter and
other technical equipment. If the defined date and time of a preventive maintenance is passed, the item is marked red.

Illustration 9.2 Preventive Maintenance

1. Double-click the cells in the right view to specify application item, action and interval.

2. Reset Maintenance Word (23-15 Reset Maintenance Word) and write to drive.

NOTICE
The clock parameters (parameters in the Clock Functions folder) must be
programmed for Preventive Maintenance to function correctly.
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9.3 Timed Actions

The Time-based Actions function enables automation of real-time controlled events.

Illustration 9.3 Time-based Actions

1. Select Timed Actions in the product folder.

2. Double-click the cells in the right view to specify

• action

• time

• recurrency

NOTICE
The clock parameters (parameters in the Clock Functions folder) must be correctly programmed for Timed Actions to
function correctly.

Actions, which can be programmed, are the same as known from the SLC (Smart Logic Controller), see 8 Smart Logic
Controller Plug-in.
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10 Multi Motor Plug-in

10.1 Multi Motor Plug-in

In applications where 1 frequency converter controls
multiple motors/fans, a motor or motor/fan coupling
failure may pass unnoticed due to missing feedback from
the controlled fan. One or few motor failures may be less
critical during low or normal operating load, but it can
lead to a full stop of the systemin high load situations. The
Multi Motor Plug-in monitors and diagnoses the fan/motor
state. The plug-in is limited to 8 motors of equal size and
type. The multi motor calculation tool is only for variable
torque applications.

Find the multi motor plug-in the drive folder in the left
side of the screen. Use the plug-in either online directly
connected to a frequency converter, or offline for
download at a later time. Find the relevant parameters in
parameter group 24-9* Application Functions 2.

NOTICE
The Multi Motor Plug-in does not work
on motors connected in parallel.

To get the right values, measure the current throughout
the whole frequency band (from 0 Hz to Max.), also below
the normal operating points.

Failures or under-load of motors issue a Missing Motor
warning. The frequency converter continuously checks if
the total motor current is below expected value, which
indicates situations where

• one or more motors are missing/disconnected

• one or more fans are loose

Overload of motors issues a Locked Rotor warning. The
frequency converter continuously checks, if the total motor
current is above the expected value, which indicates
situations where

• a rotor is locked

• a fan touches the housing

NOTICE
During start-up or dynamic events like changes in speed
references, the current may be below/above the current
threshold. Consider and evaluate whether such situations
may occur.

10.1.1 Defining Curves and Thresholds

10.1.1.1 Normal Operation Curve

The plug-in provides an easy way to find the coefficients
of the 3rd order polynomial by measuring currents on
different frequencies.

1. Measure normal operation currents on 5 different
frequencies.

2. Insert the frequencies in Normal Operation
Current, see Illustration 10.1.
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Illustration 10.1 Normal Operation Currents

NOTICE
To avoid wrong logical minimum in the 3rd order
polynomial, enter the lowest possible frequency into the
tool.

NOTICE
Points can be inserted at any frequency, but the defaults
are recommended as the points are not saved. Only
calculated coefficients are saved and used to recalculate
the points on default frequencies after closing and
opening the view.
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10.1.1.2 Threshold

Measured points represent normal operation curves.
Settings in Motor Data, see Illustration 10.2, define the
threshold of the upper and lower limits.
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Illustration 10.2 Threshold

• Number of motors is a convenience value to
reduce the tolerance bandwidth, dividing it by
the number of motors used (max. 8 motors)

• Tolerance defines the bandwidth as a percentage
to the highest measured current.

NOTICE
These settings are not saved and are recalculated after
closing and opening the view. If the values are different
after recalculation, they still define the same tolerance.
Example: 4 motors with 20% tolerance produce the same
bandwidth as 2 motors with 10% tolerance.

10.1.1.3 Coefficients

Locked rotor detection and Missing motor detection, see
Illustration 10.3, represent parameter values exactly as they
are written to drive. The values are synchronised automat-
ically.
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Illustration 10.3 Locked Rotor Detecttion and Missing Motor
Detection

NOTICE
Cubic and quadratic coefficients are multiplied by 1000
to overcome precision limitation of parameters.

10.1.2 Modifying Curves

Changing the frequency of a measured point moves the
point along the defined curve. As the point follows the
previously defined curve, the change of frequency only
causes a slight change to the curve.
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11 Cascade Controller Plug-in

The Cascade Controller is intended for pump applications
where multiple motors control a common flow, level or
pressure. By varying the speed of the motors, variable
speed control is provided for the system. This maintains
constant pressure while eliminating pressure surges,
resulting in reduced system stress and quieter operation.

3 versions of cascade controllers are available:

• Basic Cascade Controller
delivered as a part of the software in the FC 100
and FC 202. The 2 relays on the power card
control the speed of a device connected to the
frequency converter output and on/off control
devices.

• Extended Cascade Controller
allows more devices to be applied to the control
circuitry and offers additional cascade principles.
It is available only in the FC 202 with an MCO
101 option card installed.

• Advanced Cascade Controller offers the cascade
principles similar to Extended Cascade, but allows
additional devices to be applied to the control
circuitry. It is available only in the FC 202 by
utilising the MCO 102 option card.

The add-on option cards MCO 101 and MCO 102 can be
used with the Basic Cascade Controller (parameter group
25-** Cascade Conotroller) and with the Extended/advanced
Cascade Controller (parameter group 27-** Cascade CTL
Option).

The cascade controller can be configured in MCT 10 Set-up
Software from the Cascade Controller plug-in. Basic mode
supports the Basic Cascade Controller, and Extended mode
supports the Extended/Advanced cascade option MCO
101/MCO 102.

The MCT 10 Cascade Controller view is divided into 4 tabs
in both cascade modes:

• Preconditions

• Set-up

• System Optimising

• Service
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11.1 Preconditions

The preconditions tab contains the general set-up required for the Cascade Controller to operate in an application. It can
also be used in general to set up the closed loop for other applications without the need for the cascade control. Use
Preconditions to configure:

• General Configuration

• Setpoint and Feedback

• Digital Input

Illustration 11.1 Preconditions
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11.1.1 General Configuration

Closed Loop is the configuration mode of the frequency
converter. Enabling or disabling the checkbox changes the
1-00 Configuration Mode parameter.

Closed Loop checkbox 1-00 Configuration Mode parameter

Enabled [1] Closed loop

Disabled [0] Speed open loop

Table 11.1 Closed Loop checkbox options

Level Control configures the inverse mode of the PID
controller. It causes the frequency converter output
frequency to increase, when the feedback is greater than
the setpoint reference. If the checkbox is disabled, the PID
is configured to normal control. Digital I/O mode and DI32
is enabled.

Illustration 11.2 Level Control

Enabling the checkbox configures the PID to inverse
control and digital I/O mode and DI32 are disabled. The
frequency converter graphic is updated to reflect the
general configuration.

Illustration 11.3 General Configuration

The setpoint is used in closed loop as the reference to
compare the feedback values. It can be offset with the
digital, analog or bus references. Enabling the Internal
Setpoint allows for entering a numerical value for the
reference source. If the External Setpoint is selected, the
reference source is set to AI53. The internal setpoint
settings remains in the field allowing the user to switch
between a preset- or an external setpoint.

Setpoint and feedback unit type configures the pressure
unit for the closed loop setpoint and feedback. The
pressure unit can be defined in:

• %

• mbar

• bar

• Pa

• kPa

• m WG

• psi

• Ib/in2

• in WG

• ft WG

General Configuration Affected Parameters
• 1-00 Configuration Mode

• 20-81 PID Normal/ Inverse Control

• 3-15 Reference Resource 1

• 20-12 Reference/Feedback Unit
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11.1.2 Setpoint and Feedback

Configure the analog input used as setpoint and feedback.
The general configuration assumes the AI53 (Analog Input
53) is used for the Setpoint and the AI54 (Analog Input 54)
used as feedback. The signal type can only be changed
from current to voltage input with the switches on the
control board of the frequency converter. Click Show
Location to see the specific location on the frequency
converter.

Illustration 11.4 AI53 and AI54

Configure the signal type in accordance with the hardware
switches.

Push the switch to the left to
get a 0-10 V signal type.

Push the switch to the right to
get a 0-20/4-20 mA signal type.

Table 11.2 Hardware Switches

Setpoint- and Feedback High configure the analog input
scaling value corresponding to the maximum reference
feedback value. Setpoint- and Feedback Low are used to
configure the analog input scaling value corresponding to
the minimum reference feedback value. The Minimum and

Maximum references are the lowest and highest values
obtainable by adding all references together.

To receive notification of a missing or defective
transmitter, define Live Zero among the functions:

• Off

• Freeze Output

• Stop

• Jogging

• Max. speed

• Stop and trip

• Select setup 1

• Select setup 2

• Select setup 3

• Select setup 4

The function is activated, if the signal on terminal AI53 or
AI54 is below 50% of the value defined in AI53 Low or
AI54 Low. Default Live Zero timeout time is 10 s and can
be reconfigured in 6-00 Live Zero Timeout Time.

Enable Terminal 53 Live Zero and Terminal 54 Live Zero to
disable the Live Zero monitoring, if the analog outputs are
used as part of a decentral I/O system. As default, both
checkboxes are enabled.

Parameter ID Parameter Name

3-02 Minimum Reference

3-03 Maximum Reference

6-01 Live Zero Timeout

6-10 Terminal 53 Low Voltage

6-11 Terminal 53 High Voltage

6-12 Terminal 53 Low Current

6-13 Terminal 53 High Current

6-14 Terminal 53 Low Ref./Feedb. Value

6-15 Terminal 53 High Ref./Feedb. Value

6-17 Terminal 53 Live Zero

6-20 Terminal 54 Low Voltage

6-21 Terminal 54 High Voltage

6-22 Terminal 54 Low Current

6-23 Terminal 54 High Current

6-24 Terminal 54 Low Ref./Feedb. Value

6-25 Terminal 54 High Ref./Feedb. Value

6-27 Terminal 54 Live Zero

Table 11.3 Setpoint and Feedback Affected Parameters
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11.1.3 Digital Input

If a low level signal is available, the DI32 (digital input 32)
can be programmed to Stop Inverse or to External
Interlock, and an External Interlock delay can be
configured. The type of pulse to trigger, can be configured
from the Digital I/O Mode dropdown.

11.2 Set-up

The Set-up tab contains the configuration interface for the cascade controller parameter group 25-** Cascade Controller. The
cascade principle can be configured to Basic Cascade Ctrl or Motor Alternation Only (FC 202 only).
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Illustration 11.5 Configuration Interface for Parameter Group 25-** Cascade Controller
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11.2.1 Basic Cascade Control

Basic Cascade Control
Select Basic Cascade control to configure

• Motor start

• Pump configuration

• Staging/Destaging settings

Illustration 11.6 View of Basic Cascade Control Set-up Tab

View Description
Motor start This view defines the configuration

principle:

• Direct on Line – each lag pump is cut in
directly via a contactor.

• Softstarter – must be used for all fixed
speed pumps and can be used to
replace traditional contactors. When
using softstarters, a delay is added from
staging signal occurs until staging takes
place. The delay is required, due to the
ramp time of the fixed speed pump.

View Description
Enable pump
cycling

This view defines whether the pump
cycling is enabled or not:

• Disabled – lag and lead pumps will be
cut in, to have equal operating hours
for each pump.

• Enabled – Lag pumps will be cut in
according to the First in, Last out
principle.
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View Description
Fixed lead pump This view defines whether a drive uses a

fixed lead pump or not. The lead pumps
are connected directly to the relays on the
frequency converter control card. This is
illustrated in Illustration 11.6.  To obtain
equal hours of operation within the fixed
speed pumps, the lead pump can be
alternated. Timers on the relay outputs
monitor the operating hours of each pump.
When a pump is not operating over a long
time, corrosion concerns may reveal. When
it is configured for alternating lead pump,
select Alternation details to set up principles
for alternation.

Lead pump
alternation

This view instructs the drive to change the
lead pump so all pumps run for the same
period of time. The following options are
available:

• Off – no lead pump alternation occurs.

• At staging – lead pump alternation
occurs at pump staging.

• At command – lead pump alternation
occurs at explicit commands.

• At staging or command – lead pump
alternation occurs at pump staging and
at explicit commands.

Alternation Time
Interval

In this view, define the time period
between automatic alternations of the lead
pump:

• 1 to 999.9 h – when the time expires,
the lead pump alternates.

Alternation Timer
Value

This view contains the actual value of the
alternation timer.

Alternation
Predefined Time

In this view, set the time to perform an
alternation. The time format depends on
the setting configured in the frequency
converter.

Alternate if load <
50%

In this view, define whether the lead pump
must be alternated:

• Enabled – pump alternation will be
carried out only if the capacity is equal
or below 50%.

Staging Mode at
Alternation

In this view, configure the staging mode at
alternation and determine the time of the
variable speed pump deceleration:

• Quick.

• Slow.

Delay before
cutting in next
pump

In this view, set the time between stopping
the old lead pump and starting another.
Range: 0.1 s to 5.0 s.

View Description
Delay before
cutting in on mains

Time delay before a fixed speed pump is
staged on according to normal staging
sequence. When it expires, a fixed speed
pump must be staged on according to
Normal Staging.
Range: 0.1 s to 5.0 s.

Staging/Destaging
settings

In this view, configure when to add and
remove a stage from a running application.
A stage is a representation of a 100%
pump.

Staging Bandwidth
(SBW)

In this view, defines the band around the
head set point and configure it as a
percentage of the maximum reference. If
the actual head exceeds the bandwidth for
a specified time and the speed is at Motor
speed high limit, a stage is added. If the
speed is at Motor speed low limit, a stage
is removed.
Range: 1 to 100%.

Override
Bandwidth (OBW)

Preserves a stable head in the application.
When quick changes in the system
demands occur, the override bandwidth
must add/remove a stage immediately,
when the actual exceeds override
bandwidth. To avoid unintended staging
until the head has settled after start,
override bandwidth has a delay until the
lead pump has reached Motor Nominal
Speed or Motor Speed High Limit after a
start command.
Range: SBW to 100%.

Fixed Speed Pumps
Staging Bandwidth
(FSBW)

Ensures that the cascade controller
continues, if the frequency converter issues
an alarm. Keeping the head on the setpoint
requires a frequent staging and destaging.
When only fixed speed pumps are running,
a wider bandwidth (FSBW) is used instead
of SBW.
Range: SBW to OBW.

OBW timer Avoids frequent staging/destaging. The
OBW timer prevents staging a pump until
the application pressure is stabilised.
Range: 0-300 s.

SBW Staging Delay Delay between the feedback signal being
below the staging bandwidth and a lag
pump being added. SBW Destaging Delay is
the time between when the feedback signal
is above the staging bandwidth and when
a lag pump is removed.
Range: 0-3000 s.
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View Description
Ramp Down- and
Up Delay

For use with Sofstarters. The Ramp Down
Delay is for setting the lead pump ramp
down delay before staging a fixed speed
pump on. Ramp Up Delay is for setting the
lead pump ramp up delay before a fixed
speed pump is destaged.

Stage- and Destage
Threshold

The percentage of maximum pump speed
to stage on and to destage fixed speed
pump. The thresholds must be configured
as a percentage of Motor Speed High limit

Destaging speed To prevent an overshoot when adding a
fixed speed pump, the variable speed
pump ramps to Motor speed low limit.
When the variable pump reaches Staging
Speed, the fixed speed pump is staged on.
To prevent an undershoot when removing
a fixed speed pump, the variable speed
pump ramps to Motor Spee High Limit.
Available options: RPM or Hz

Enable Staging
Function

Avoids frequent staging of fixed speed
pumps. Enabling the check box starts the
stage function timer. Enable Destage
Function ensures the lowest numbers of
pumps are running to save energy and to
avoid dead head water circulation in the
variable speed pump. Enabling the
checkbox starts the destage function timer.

Table 11.4 View and Selection Descriptions

Function Number of pumps

Fixed lead pump 2-3

Alternating lead pump 2

Table 11.5 Number of Pumps Configurable from the Drop-down

Illustration 11.7 Alternation Details
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If configuring the Lead Pump Alternation At command or At stating or command, the Alternation Event can be configured to:

• External – Alternation takes place when a signal is applied to one of the digital inputs in the terminal strip.

• Alternation Time Interval – Alternation takes place every time Alternation Time Interval expires.

• Sleep Mode – Alternation takes place each time the lead pump goes into sleep mode. No flow function must be
set to Sleep Mode or an external signal applied for this function.

• Predefined Time – Alternation takes place at a defined time of the day. If Alternation Predefined Time is set, the
alternation is carried out every day at the specified time.

Illustration 11.8 Staging and Destaging Details

Stage Function Time is the time before staging on a fixed
speed if the lead pump is at maximum speed. The stage
timer starts when the adjustable speed pump is running at
Motor Speed High Limit with one or more constant speed
pumps stopped. When the timer expires, a fixed speed
pump is staged. The Destage Function Time is the time
before staging on a fixed speed, if the lead pump is at
minimum speed. It starts when the adjustable speed pump
is running at Motor Speed Low Limit with one or more fixed
speed pumps in operation. When the timer expires, a stage
is removed avoiding dead head water circulation within
the adjustable speed pump.

If the  Destage At No-Flow checkbox is enabled, a stage is
removed when there is No Flow situation.

11.2.2 Motor Alternation Only

In Motor Alternation Only one frequency converter and two
pumps are connected through contactors to both the
frequency converter and to mains. The functionality is used
to allow the alternation between pumps that share a
frequency converter. The alternation takes place at an
external command signal or a pre-programmed event.
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11.3 System Optimizing

The System Optimizing tab provides a simple way to start
and stop the Cascade Controller run. It allows for
configuring:

• PID Controller

• Feedback low pass filter

Illustration 11.9 Start and Stop Cascade Controller

Field Description
PID Anti
Windup

Controls the integration of the PID Controller. If the
checkbox is enabled, the PID Controller stops
integrating the error between the feedback and the
set-point reference, if its not possible to adjust the
output frequency of the frequency converter, to
correct the error. This situation can occur when the
frequency converter has reached the minimun or
maximum output frequency, or when the frequency
converter is stopped. If the checkbox is disabled,
the PID controller continues integrating the error
between the feedback and set-point reference, even
through the frequency converter cannot adjust its
output frequency to correct this error.

PID
Propor-
tional Gain

Adjusts the output of the frequency converters PID
controller based on the error between the feedback
and the set-point reference. Quick PID Controller
response is obtained using a large value. If too
large, the frequency converter output frequency
may become unstable. The value is configurable
from 0 to 10.00.

Field Description
PID
Integral
Time

The duration of integrating the error between the
feedback and the set-point reference, to ensure the
error approaches zero. Quick speed adjustments is
obtained using a short duration. A too short value.
the frequency converter output frequency may
become unstable. The time is configurable from
0.01 to 10000.00 s.

PID Differ-
entiation
Time

The duration the differentiator monitors the rate of
change of the feedback. If its quickly changing, it
adjusts the output of the PID Controller to reduce
the rate of change of the feedback. Quick PID
controller responses are obtained using a large
duration. However, if too large value, the frequency
converter output frequency may become unstable.
Differential time is useful in situations where very
fast responses and precise speed control is required.
The time is configurable from 0.00 to 10.00 seconds.

Terminal
54 Filter
Time
Constant

A first order digital low pass filter constant for
suppressing electrical noise from terminal 54. A high
time constant improves the dampening, but also
increases the time delay through the filter. The
value can only be adjusted, while the frequency
converter is stopped. The time constant can be
configured from 0.001 to 10.000 s.

Table 11.6 Description of PID functions

11.4 Service

The Service tab provides a simple way to make Cascade
Controller service.

View Description Basic
cascade

controller

Extended
cascade

controller
Cascade
status

 ✓ ✓

Pump
status

Readout of the status for
each pump selected with
a string which consists of
the pump number and
the current status of the
pump.
A readout with two
pumps could be “1:D
2:O”.

• 1:D – Pump 1
Running on frequency
converter.

• 2:O – Pump 2 Off.

✓ ✓
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View Description Basic
cascade

controller

Extended
cascade

controller
Lead pump Shows the actual lead

pump in the application.
When an alternation
takes place, the field is
updated to reflect the
current lead pump.

✓ ✓

Manual
alternation

Select a new lead pump.
The items available from
the drop down is Off to
the number of pumps.

✓ ✗

Relay status Select Relay Status to
update the status of the
relays.
The status can be

• On - the relay is
activated

• Off - the relay is
deactivated

The values can only be
updated if the frequency
converter is online.

✓ ✓

Relay ON
time

Monitors the total
operating hours of the
connected relay. The
resolution is in operating
hours.
Reset Relay Counter resets
all Relay On Times. It is
only available, if the
frequency converters is
connected online.

✓ ✗

View Description Basic
cascade

controller

Extended
cascade

controller
Pump
interlock

Disables a certain pump
and is configurable from
a checkbox located at
each pump.

✓ ✗

Pump ON
Time

Monitors the total
operating hours of the
connected pump. The
resolution is in operating
hours. Reset clears the
operating hours of a
specific pump.

✓ ✗

Current
runtime
hours

Readout of the total
number of operating
hours for each pump
since last reset. The time
is used to balance the
operating hours between
pumps.

✗ ✓

Pump total
lifetime
hours

Total operating hours for
each connected pump.

✗ ✓

Manual
pumps
control

Readout of the command
parameter that allows
manual control of
individual pump states.

✗ ✓

Reset relay
counter

Resets all Relay On times.
Only available if the
frequency converter is
online.

✗ ✓

Table 11.7 Service Tab Views
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Illustration 11.10 Service Tab Basic Cascade Controller

Illustration 11.11 Service Tab Extended Cascade Controller
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View Status Status description

Cascade status Disabled Cascade controller is disabled

Emergency All pumps have been stopped by a Coast/Coast inverse or an External Interlock command applied
to the frequency converter

Off All pumps have been stopped by a stop command applied to the frequency converter

In Open Loop Configuration Mode has been set for Open Loop. All fixed speed pumps are stopped and the
variable speed pump continues to run

Frozen Staging/destaging of pumps has been locked and the reference is locked

Jogging All fixed speed pumps are stopped. When stopped, the variable speed pump runs at jog speed

Running A start command is applied to the frequency converter and the cascade controller is controlling
the pumps

Running FSBW the frequency is tripped off and the Cascade Controller is controlling the fixed speed pumps
based on Fixed Speed Bandwidth

Staging The Cascade Controller is staging fixed speed pumps

Destaging The Cascade Controller is destaging fixed speed pumps

Alternating The Lead Pump Alternation selection is different than Off and an alternation sequence is taking
place

Lead Not Set No pump available to be assigned as variable speed pump

Pump Status X Disabled. The pump is interlocked either via Pump interlock or signal on a digital input
programmed for Pump Interlock in Digital inputs

Off Stopped by the Cascade Controller, but not interlocked

D Running on frequency converter. Variable speed pump, regardless if connected directly or
controlled via relay in the frequency converter

R Running on mains. Fixed speed pump running

Relay status1) On The relay is activated

Off The relay is deactivated

Manual pump control2) No operation The function is disabled

Online Makes the pump available of the cascade controller

Alternate On Forces the selected pump to be the lead pump

Offline-Off Turns the pump off and makes the pump unavailable for cascading

Offline-On Turns the pump on and makes the pump unavailable for cascading

Offline-Spin Initiates a pump spin

Table 11.8 Status Descriptions

1)  Only available in Basic cascade controller
2)  Only available in Extended cascade controller

Relay Status enables readout of the function and status of each relay.
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Illustration 11.12 Relay Status

11.5 Extended Cascade Controller Functions

Is the interface for setting up the add-on cascade controller option. The Cascade Mode drop-down is extended with Master/
Follower and Mixed Pumps.

Illustration 11.13 Relay Status

11.5.1 Master/Follower

This view allows for configuring:

• Motor Start

• Pump Configuration

• Connections
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• Staging/Destaging

• Master Pulse Output Signal

• Spin time unused pump

• Runtime Balancing

Illustration 11.14 Master/Follower

The Motor Start drop-down is similar the configuration available in 11.2.1 Basic Cascade Control.

Each pump is controlled by a frequency converter and the number of frequency converters corresponds the number of
pumps. Staging and destaging are done based on the speed of the frequency converter. The constant pressure is controlled
by the master frequency converter operating in closed loop. Up to 6 pumps can be controlled with MCO 101 and up to 8
with the MCO 102 add-on option.

Select Connections to configure the relay function for each relay in the application.
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Illustration 11.15 Configure Relay Function

NOTICE
Number of available relays depends on add-on option.

To set up the function of each relay, double-click the Value field and select the relay from the drop-down list. If add-on
option MCO 102 is installed, the relay option MCB 105 may also be used as an expansion.

Select Staging/Destaging settings to configure when to add and remove a stage from a running application. All stages are a
representation of 100% pumps in Master/Follower.

Illustration 11.16 Staging and Destaging Details
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Field Description

Normal
Operating
Range

The allowed offset from the set-point before a
pump may be added or removed. The system
must be out of the limit for the time specified
in Staging Delay.

Override Limit The allowed offset from the set-point before a
pump immediately is added or removed.

Autotune
Stage/Destage
Threshold

Optimises the threshold values during
operation. The settings are updated to prevent
pressure over and undershoots when staging
and destaging.

Autotune Stage
On/Off Speeds

Stage on and off speeds are continually auto
tuned during operation. Sittings are optimised
to ensure high performance and low energy
consumption.

Table 11.9 Staging and Destaging Descriptions

All supported stages On and Off settings can be
configured in RPM or Hz. Select Example to see a configu-
ration example of 3 pumps.

Ramp Down- and Ramp Up Delay are only configurable
when the Motor Start is configured to Softstarter.

Select Master Pulse Output Signal to configure terminal 27
on the master frequency converter.

Illustration 11.17 Master Pulse Output Signal

In some applications, not all pumps are used on a regularly
basis. Select Spin time unused pump to configure the time a
pump is allowed to idle.

Illustration 11.18 Spin Time unused Pump

Select Runtime balancing to balance the running hours of
the available pumps. 3 balancing priorities are available for
each pump.

Illustration 11.19 Balance Running Hours

11.5.2 Mixed Pumps

Select Mixed pumps to configure:

• Motor Start

• Pump configuration

• Pump Size

• Connections

• Alternation Details

• Staging/Destaging settings

• Spin time unused pump

• Runtime Balancing
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The  Motor Start drop-down list is similar to 11.2.1 Basic
Cascade Control, but with the additional possibility to
configure Star/Delta.

Mixed Pumps Cascade Mode can be configured to:

Mode Description

Mixed pump A mix of variable speed pumps connected
to frequency converters as well as additional
fixed speed pumps.

Unequal size
pump

limited mix of fixed speed pumps in
different sizes.

Mixed pump with
alternation

alternates the frequency converter between
two pumps along with controlling additional
fixed speed pumps.

Table 11.10 Mixed Pump Cascade Modes

Up to 6 pumps can be controlled with MCO 101 and up to
8 with the MCO 102 add-on option.

Select Pump size to configure the fixed pump capacity in
the application. All variable speed pumps are read only
and 100% in capacity.

Illustration 11.20 Configure Fixed Pump Capacity

For configuration of Connection, refer to 11.5.1 Master/Follower configuration. For Mixed Pumps Alternation Details configu-
ration, refer to11.2.1 Basic Cascade Control.

The dialog Staging/Destaging settings is similar to 11.2.1 Basic Cascade Control with the additional option to configure Min
speed Destage Delay. Configure for how many seconds the lead pump must run at minimum speed while system feedback is
in normal operating band. When the time has elapsed, the pump turns off to save energy.

Illustration 11.21 Staging/Destaging

Spin time unused pump and Runtime Balancing configuration is similar to the Master/Follower configuration.

Cascade Controller Plug-in VLT® MCT 10 Set-up Software

MG10RA02 - VLT® is a registred Danfoss trademark 83

11 11



12 Drive File Manager Plug-in

Provides the functionality to download files containing Customer Specific Initialization Values (CSIV), language files and
application wizard files to the frequency converter. CSIV files contain parameter sets that can be used to initialise the
frequency converter to reduce the time for commissioning. Files can only be flashed via the serial bus RS-485 with the
frequency converter serial address configured to 1.

 View Drive
Flash File

System

Download CSIV
Files

Delete CSIV
Files

Download
Language Files

Delete
Language Files

Download
application
wizard files

Delete
application
wizard files

FC 51 N/A N/A N/A N/A N/A N/A N/A

FC 101 N/A N/A N/A N/A N/A N/A N/A

MCB 102 Yes Yes Yes Yes Yes N/A N/A

FC 202 Yes Yes Yes Yes Yes N/A N/A

FC 300 Yes Yes Yes Yes Yes Yes* Yes*

Derived
versions of the
FC series

Yes Yes Yes Yes Yes N/A N/A

AAF005 Yes Yes Yes Yes Yes N/A N/A

Table 12.1 Available Features

* Only FC 302 from firmware version 6.6x.

The functionality is available as a plug-in named Drive File
System and is accessible both from Network and Project
nodes.
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Illustration 12.1 Drive File Manager Plug-In

From the Network node it is only possible to view the
content in the Drive Flash File System. It requires a change
of the frequency converter serial protocol 8-30 Protocol to
[1] FC MC. CSIV and language files can only be
downloaded from the Project node.
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12.1 Creating CSIV Files

New CSIV files can be created by right-clicking from the Drive File Manager right pane and selecting New File ⇒ CSIV File. An
empty CSIV file is created and listed in the right view with the default name starting from 1.
Additionally, existing CSIV files or language files can be imported to the list by selecting Import File from the menu.
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Illustration 12.2 Create CSIV Files

CSIV files containing initialisation values can be exported to a file by selecting Export File from the menu. Traditionally, from
the file menu it is possible to Cut, Copy, Paste, Delete or Rename existing files from the list.
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12.2 Configuring CSIV Files

The CSIV file content is auto generated based on the settings configured in the File menu.
Full Change set – builds up the CSIV file content based on the changes made by the user in the project including all the
dependant parameters.
Minimal change set - builds up the CSIV file content based on changes made by the user only. Selecting this option, the
CSIV file is independent from the frequency converter firmware version, except if one of the user-configured parameters is
not available.

Use an editor to configure the CSIV file. To open the editor, double-click a file from the list or select Edit File from the menu.
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Illustration 12.3 Parameter Settings Imported from the Project and the Actual CSIV File Content

Left View contains the parameter settings imported from
the project. Right View lists the actual CSIV file content.

1. Edit the relevant parameter settings in the Edit
parameters below view.
It is possible to undo the changes made from the
Options menu.
Revert parameters to project drive settings – applies
the initialisation values to CSIV file contents
corresponding to the original project.
Reset to default values - resets all parameters to
Factory configuration and erases the CSIV file
content.

2. Press Save to save the parameter settings from
the File content to the CSIV file.

Press Cancel to discard all changes and close the
CSIV editor.

As part of the CSIV content, the frequency converter
information is also saved to the file. When opening the file
in the CSIV editor a validation is made to check for
compatibility.
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Illustration 12.4 Validation

When parameter settings have been saved to the file, open
it for validation.

12.3 Drive File Manager

Files can be downloaded or existing ones erased in the frequency converter from the Drive File Manager available from the
menu.
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Illustration 12.5 Drive File Manager
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The frequency converter is set into service mode when
opening the Drive File Manager.

NOTICE
If the connection is lost, or the frequency converter is
power cycled, the frequency converter remains in service
mode. It can be forced back to normal mode with the
Software Upgrader plug-in.
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Illustration 12.6 Service Mode

The Drive File Manager is divided in a left pane named
Project Drive and a right pane named Connected Drive.
Project Drive – lists the files in the project.
Connected Drive – lists the files present in the frequency
converter flash file system.
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Illustration 12.7 Present Files

3 buttons are located in the middle of the view

Illustration 12.8 Right Arrow

Right arrow transfers the file(s) from the project to the
frequency converter Flash File System.

Illustration 12.9 Left Arrow

Left arrow transfers the file(s) from the frequency converter
Flash File System to the project.

Illustration 12.10 Exit

Exit button closes the frequency converter File Manager
and switches the frequency converter back to normal
mode.
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13 Functional Safety Configuration Plug-in

13.1 Introduction

The MCB 15x safety functions are defined in the Safety configuration Plug-in

• Configuration of the safety functions for safe motion; these shut down the frequency converter in the event of an
error

• Setting of

• limit values

• braking ramps for the safety functions

• monitoring of motion sequences

The manuals listed below contain important information about safety systems that must be used to mount and set up the
speed monitoring safety functions of the MCB 15x module.
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 + MCT 10 + Safe Plug- in Commissioning Report

Install

Use Manual for FC 

Use Manual for MCB 15x

Parameterize

Use Manual for 

MCT 10 Safe

Plug-in

Test

Use Commissioning

Report generated via 
MCT 10 Safe Plug-in

Report

Rev.Sequence: A, 3

MCT 10

Commisioning report

3 February 2012
Property of Danfoss A/S. Not to be handed over to, copied, or used by third party. Two - or three - dimensional

reproduction of contents to be authorized by Danfoss A/S. 

302

FC 302 MCB 15x

Illustration 13.1 System Overview

Referenced literature

• VLT® AutomationDrive FC 302 Operating Instructions
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13.1.1 Safe Option Compatibility

MCB 15x Safe Option is supported from SW version 6.64.
Previous versions are not supported. The following
fieldbusses are supported by MCB 15x Safe plug-in:

• Serial Communication

• RS-232 to RS-485

• USB to RS-485

• USB

• PROFIBUS DP.V1

The MCT 10 safe plug-in for the MCB 15x safe option offers
the following features

• Offline project planning and preparation for
safety functions

• Commissioning of safety configurations

• Creating backups of safety configurations

• Safe Option diagnostics

• Monitoring active frequency converters for
behaviour and error codes

13.2 Access

13.2.1 Password Management

Access to the Safe Option is restricted with passwords. The
password is requested every time the user commissions a
new set-up for the device.

13.2.2 Safe Plug-In for MCB 15x Safe
Option
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Illustration 13.2 The Safe Plug-In for MCB 15x (Safe) shown
with Functional Safety Icon in Project Tree

To access the Safe plug-in for MCB 15x for the desired
frequency converter, expand the frequency converter’s
Network or Project view, then expand the relevant
frequency converter to display its contents. Press the Safe
icon to display the Safe plug-in for MCB 15x plug-in
interface in the Right View of the MCT 10 Set-up Software.

In case of multiple separate online or offline frequency
converters, select the relevant frequency converter to
monitor from the structure tree.
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NOTICE
The parameters that can be edited using the Safe plug-in
for MCB 15x Safe Option are also included in parameter
group 42-** Safety Functions in the All Parameters group
of the structure tree. These parameters can only be
edited using the Safe plug-in for MCB 15x.

To review parameter group 42-** Safety Functions in All
Parameters view, expand the All Parameters group beneath
the desired frequency converter and select the 42-** Safety
Functions entity. The parameter grid is displayed on the
right.

13.3 Safe Plug-In Interface

The layout of the plug-in is divided into separate sections that are all described in more detail below.
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Illustration 13.3 The Opening Tab of the Safe Plug-In for MCB 15x Plug-in Interface (Operating in Offline Mode).

The Safe plug-in for MCB 15x Safe Option features tooltips for all plug-in interface components. Briefly hovering the mouse
cursor over any interface component reveals a tooltip detailing the current option, LED or tab header. Refer to these tool
tips for quick and easy help information.
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Illustration 13.4 Tool Tip Example
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13.3.1 Information and Administration Area

Illustration 13.5 Safe Plug-In for MCB15x Information and Administration Area

The information area at the top of the plug-in interface
displays the current Safe plug-in for MCB 15x profile name
and notifies the user of pending changes.

Depending on mode, further options are available in the
information area.

• Offline mode: in case if a frequency converter is
connected, press Write to drive and upload the
configuration to the MCB 15x

• Online mode: 2 more selections are present in
the Information area

- Administration

- Change password

The Notification icon is displayed, when there are changes
pending for the frequency converter that have not yet
been written to it. This icon is displayed at every configu-
ration update. The icon is removed from the view only
after a successful commissioning procedure.
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13.3.2 LED Status Area

The left hand side of the Safe plug-in for MCB 15x Safe
Option contains the Status pane. The Status pane contains
informative LED status icons that help to monitor the
functionality and status of the Safe plug-in for MCB 15x
Safe Option configuration entities.
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Illustration 13.6 LED Status Area

NOTICE
The LED icons are active only when Safe plug-in for MCB
15x is accessed in online network mode. When working
in offline project mode, the LEDs remain inactive (grey).

LED
Status Description

(green) OK state – the options is enabled or active

(flashing
green)

Pending state – the option is pending. This applies
only to DI1 and DI2 LEDs

(yellow) Active state – the option is active

(flashing
red)

Warning state – the option has encountered a
warning state

(red) Error state – the option has encountered an error

(grey)
Off state – the option is either disabled, offline or
inactive

Table 13.1 LED Status Information

DI1 Status of Digital Input 1

DI2 Status of Digital Input 2

S37 Status of S37 Safe Output for terminal T37 on the
FC

STO Status of Safe Torque Off

SS1-A Status of Safe Stop 1 A

SS1-B Status of Safe Stop 1 B

SLS-A Status of Safe Limited Speed A

SLS-B Status of Safe Limited Speed B

Power cycle
required

This LED is highlighted when the device requires
a power cycle

Input offline
test

Digital inputs must be tested once a year. This is
indicated by a warning

Blank initial If the LED is highlighted, the Option is in a blank
initial state, i.e. in factory settings. When writing
to the Option for the first time, provide a new
password

Error The MCB 15x has detected an error. The specific
error code is displayed in the error code display
below the error LED. For more information
regarding error codes, refer to 15.3.3 Device Error
Codes

Table 13.2 Safe Option Status LEDs

13.3.3 Configuration Area

The configuration area contains dedicated sections/tabs for
configuring the safety functions.

The sequence of tabs represents the order in which the
settings should be configured.

The following sections detail the contents of the configu-
ration tabs

• General Speed Monitoring

• Safe Input

• Safe Stop 1

• Safely Limited Speed

The last tab Parameters contains a table layout of all
configuration options, intended for advanced users.
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13.3.4 General Speed Monitoring

The general speed monitoring tab contains primary and general information regarding the encoder/proximity switch
feedback setup details.
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Illustration 13.7 General Speed Monitoring Configuration Tab

The left side of the tab contains the following configuration options:

Option Description

Measured
speed source

This option defines the measured speed feedback source. The following options are available:

• Safe plug-in for MCB 15x – the feedback source is Safe plug-in for MCB 15x

• None – no feedback source is used

• Factory default: [Safe plug-in for MCB 15x]

Mounting
type

This option defines the frequency converter mounting type. The following options are available:

• Gear mounted – the frequency converter is mounted using a gear system

• Motor shaft mounted – the frequency converter is mounted directly to the application

Gear ratio
This option defines the ratio between motor shaft and the encoder speed.
Range: 0.0001 and 32.0000
Factory default: 1.0000

MCB150
encoder
resolution

This option defines the encoder resolution connected to the Safe plug-in for MCB 15x.
Range: 1 and 4096 PPR for HTL and 1 and 10,000 PPR for TTL
Factory default is 1024 PPR.
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Option Description

Encoder
direction

This option provides the option to change the detected encoder rotation direction without altering the wiring to the
encoder itself. The following options are available:

• Clockwise – i.e. positive feedback when the encoder rotates clockwise

• Counter clockwise – i.e. positive feedback when the encoder rotates counter clockwise

Factory default: [Clockwise]

Feedback
type

This option defines the feedback type. The following options are available:

• With direction info – the feedback provides direction information, e.g. an encoder

• Without direction info – the feedback does not provide direction information (proximity switch configuration)

Factory default: [With direction info]

Feedback
filter

This option defines the frequency used by the feedback filter for low resolution encoder or proximity switch. The filter is
required to reduce the quantization noise from the connected encoder or proximity switch in the case of low resolution.
Range : 0.01-200 Hz (off)
Factory default: [200 Hz (off)]

Zero speed
timer

This option allows the speed to be below 120 RPM when SLS is active before STO is engaged.
Range: 0 and 10,000 s
Factory default: [10].

Table 13.3 Options for General Speed Monitoring
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13.3.5 Safe Input

The safe input configuration tab details the input channel, settings, failure reaction and reset functions that are mapped
into the Safe Option.
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Illustration 13.8 Safe Input Configuration Tab

The safe input tab contains the following separated sections with the following configuration possibilities:
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Function:

Option Description

DI1 Safe
Function

This option defines the safe function used by DI1. The following options are available:

• STO – safe torque off is used as the safe function by DI1

• SS1-A – safe stop 1 A is used as the safe function by DI1

• SS1-B – safe stop 1 B is used as the safe function by DI1

• SLS-A – safe limited speed A is used as the safe function by DI1

• SLS-B – safe limited speed B is used as the safe function by DI1

• Disabled – the DI1 safe function is disabled

Factory default: [STO]

DI1 Type

This option defines the DI1 type used. The following options are available:

• NCNC – NCNC type is used

• Antivalent – NO/NC (antivalent) type is used

• NC – 1 NC input type is used.

Factory default: [NCNC]

DI1 Restart
behavior

Restart of the Safe Option configured the DI1 restart behaviour. The following options are available:

• Manual – the restart is performed manually

Factory default: [Manual]

DI2 Safe
Function

This option defines the safe function used by DI2. The following options are available:

• STO – safe torque off is used as the safe function by DI2

• SS1-A – safe stop 1 A is used as the safe function by DI2

• SS1-B – safe stop 1 B is used as the safe function by DI2

• SLS-A – safe limited speed A is used as the safe function by DI2

• SLS-B – safe limited speed B is used as the safe function by DI2

• Disabled – the DI2 safe function is disabled

• Restart DI1 and Failure ACK – DI1 is restarted

Factory default: [STO]

DI2 Type

This option defines the DI2 type used. The following options are available:

• NCNC – NCNC type is used

• Antivalent – NO/NC (antivalent) type is used

• NC – 1 NC input type is used

Factory default: [NCNC]

DI2 Restart
behaviour

This option defines the DI2 restart behaviour. The following options are available:

• Manual – the restart is performed manually

• Automatic – the restart is performed automatically

Factory default: [Manual]

Table 13.4 Options for Safe Input
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Option Description

DI1 Discrepancy time
This option defines the time for the DI1 signal discrepancy.
Range: 0-5000 ms
Factory default: 10 ms

DI1 Stable signal time
This option defines the time for the DI1 signal to become stable.
Range: 0-5000 ms
Factory default: 10 ms

DI2 Discrepancy time
This option defines the time for the DI2 signal discrepancy.
Range: 0-5000 ms
Factory default: 10 ms

DI2 Stable signal time
This option defines the time for the DI2 signal to become stable.
Range: 0-5000 ms
Factory default: 10 ms

Table 13.5 Options for Input settings

Option Description

External failure reaction

This option defines the reaction that will be executed in the case of an external failure. The following
options are available:

• STO – STO is executed

• SS1-A – SS1-A is executed

• SS1-B – SS1-B is executed

Factory default: [STO]

Table 13.6 Options for Failure reaction

Option Description

Reset source

This option defines the source for the reset signal for Safe plug-in for MCB 15x. The following options are available:

• Drive Reset – source is a frequency converter reset

• Drive Safe Reset – source is a safe drive reset

• Safe Option DI2_A – source is Safe Option DI2_A

Factory default: [Drive Reset]

Table 13.7 Options for Reset Settings
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13.3.6 Safe Stop 1

The safe stop configuration tab allows setting specific scenarios for safe stopping of the frequency converters using
designated conditions.
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Illustration 13.9 Safe Stop 1 Configuration Tab

The safe stopping tab contains the following separated sections with the following configuration possibilities:

Option Description

Type

This option defines the type of the safe stopping configuration. The following options are available:

• Delay – a delay is used to safely stop the frequency converter

• Ramp– a ramp is used to safely stop the frequency converter

Factory default: [Delay]

Functional Safety Configura... VLT® MCT 10 Set-up Software

MG10RA02 - VLT® is a registred Danfoss trademark 99

13 13



Option Description

Type: Delay

The following configuration options are available when the type is set to Delay:

Delay time

This option defines the amount of time that is used by the SS1 delay function to ramp the
speed down to 0 RPM.
Range: 0.1-3600 s
Factory default: 1 s

Ramp profile

This option defines the ramp profile setting. The following options are available:

• Linear – a linear ramp is used for the delay

• S-Ramp Const. Time – a constant time ramp is used to safely stop the frequency
converter

Factory default: [Linear]

Delta time
This option defines buffer time that is added to the delay time before activating STO.
Range: 0-99%

S-ramp ratio start

This option is configurable only when S-Ramp Const. Time is selected as the Ramp profile.
This option defines the proportion of the total ramp-down time where the deceleration
torque increases. The greater the percentage value, the greater the jerk compensation
achieved, and thus the lower the torque jerks in the application.
Range: 1-50%
Factory default: [50%]

S-ramp ratio end

This option is configurable only when S-Ramp Const. Time is selected as the Ramp profile.
This option defines the proportion of the total ramp-down time where the deceleration
torque decreases. The greater the percentage value, the greater the jerk compensation
achieved, and thus the lower the torque jerks in the application.
Range: 1-50%
Factory default: [50%]

Type: Ramp

The following configuration options are available when the type is set to Ramp:

Ramping setup

This option defines the ramping setup used. The following options are available:

• Slope – a sloping ramp is used

• Time – a time ramp is used

Deceleration rate

This option is configurable only when Slope is selected for the Ramping set-up. This option
defines the deceleration rate for the SS1 slope based ramp style.
Range: 1-30.000 RPM/s
Factory default: [1.500 RPM/s]

Ramp time
This option is configurable only when Time is selected for the Ramping setup. Itdefines the
time after which Safe plug-in for MCB 15x will engage the STO.

Delta V

This option defines the tolerance between the calculated speed and the actual speed that
Safe plug-in for MCB 15x allows.
Range: 1-10.000 RPM
Factory default: [120 RPM]

Zero speed
This option defines the speed at which Safe plug-in for MCB 15x engages STO.
Range: 1-600 RPM
The factory default: [10 RPM]

Table 13.8 Options for SS1-A
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Option Description

Type

This option defines the type of the safe stopping configuration. The following options are available:

• Delay – a delay is used to safely stop the frequency converter

• Ramp– a ramp is used to safely stop the frequency converter

Factory default: [Delay]

Type: Delay

The following configuration options are available when the type is set to Delay:

Delay time

This option defines the amount of time that is used by the SS1 delay function to ramp the
speed down to 0 RPM.
Range: 0.1-3600 s
Factory default: [1 s]

Ramp profile

This option defines the ramp profile setting. The following options are available:

• Linear – a linear ramp is used for the delay

• S-Ramp Const. Time – a constant time ramp is used to safely stop the frequency
converter

Factory default: [Linear]

Delta time
This option defines buffer time that is added to the delay time before activating STO.
Range: 0-99%

S-ramp ratio start

This option is configurable only when S-Ramp Const Time is selected as the Ramp profile.
This option defines the proportion of the total ramp-down time where the deceleration
torque increases. The greater the percentage value, the greater the jerk compensation
achieved, and thus the lower the torque jerks in the application.
Range: 1-50%
Factory default: [50%]

S-ramp ratio end

This option is configurable only when S-Ramp Const Time is selected as the Ramp profile.
This option defines the proportion of the total ramp-down time where the deceleration
torque decreases. The greater the percentage value, the greater the jerk compensation
achieved, and thus the lower the torque jerks in the application.
Range: 1-50%
Factory default: [50%]

Type: Ramp

The following configuration options are available when the type is set to Ramp:

Ramping setup

This option defines the ramping setup used. The following options are available:

• Slope – a sloping ramp is used

• Time – a time ramp is used

Deceleration rate

This option is configurable only when Slope is selected for the Ramping setup. This option
defines the deceleration rate for the SS1 slope based ramp style.
Range: 1-30.000 RPM/s
Factory default: [1.500]

Ramp time
This option is configurable only when Time is selected for the Ramping setup. It defines the
time after which Safe plug-in for MCB 15x engages the STO.

Delta V

This option defines the tolerance between the calculated speed and the actual speed that
Safe plug-in for MCB 15x allows.
Range: 1-10.000 RPM
Factory default: [120 RPM]

Zero speed

This option defines the speed at which Safe plug-in for MCB 15x will engage STO.
Range: 1-600 RPM
Factory default: [10 RPM]

Table 13.9 Options for SS1-B
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13.3.7 Safely Limited Speed

The safely limited speed configuration tab allows setting specific scenarios for safe limited speeds of the frequency
converters using designated conditions.
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Illustration 13.10 Safely Limited Speed Configuration Tab

The safely limited speed contains the following separated sections with the following configuration possibilities:

Option Description

SLS setup

This option defines the type of the safe limited speed setup. The following options are available:

• SLS without ramp – SLS is used without a ramp

• SLS with ramp – SLS is used with ramp

Ramp Down Time

This option is configurable only when the SLS with ramp is selected in SLS setup. It defines the time ramp down
time for start ramp.
Range: 0.1-3.600 s
Factory default: [1 s]
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Option Description

Cut off speed
This option defines the speed at which the Fail Safe Reaction is activated. This setting should equal the value of
the Speed Limit parameter plus tolerance.
Range: 1-10.000 RPM

Speed limit
This option defines the maximum allowed speed when the SLS function is engaged. This is a speed unit measured
in RPM.

Failsafe reaction

This option defines the safety function that is engaged when the maximum speed is exceeded. The following
options are available:

• STO – safe torque off is used

• SS1-A – safe stop 1-A is used

• SS1-B – safe stop 1-B is used

Table 13.10 Options for SLS-A

Option Description

SLS setup

This option defines the type of the safe limited speed setup. The following options are available:

• SLS without ramp – SLS is used without a ramp

• SLS with ramp – SLS is used with ramp

Ramp Down Time

This option is configurable only when the SLS with ramp is selected in SLS setup. It defines the time ramp
down time for start ramp.
Range: 0.1-3.600 s
Factory default: [1 s]

Cut off speed
This option defines the speed at which the Fail Safe Reaction is activated. This setting should equal the value
of the Speed Limit parameter plus tolerance.
Range: 1-10.000 RPM

Speed limit
This option defines the maximum allowed speed when the SLS function is engaged. This is a speed unit
measured in RPM.

Failsafe reaction

This option defines the safety function that is engaged when the maximum speed is exceeded. The following
options are available:

• STO – safe torque off is used

• SS1-A – safe stop 1-A is used

• SS1-B – safe stop 1-B is used

Table 13.11 Options for SLS-B
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13.4 Configuration

Configure the Safe Plug-In in online mode (PC connected
to frequency converter) or in offline mode (no PC
connected to frequency converter). In both cases, enter the
required values in the configuration dialogs to configure
the Plug-In.

NOTICE
Multiple value entry fields in the configuration tabs are
accompanied by recommended value settings that
appear below the text field.
The recommended values are generated dynamically
based on the user input of related and dependent
configuration options.
To apply a recommended value to a field, press the
underlined  Apply link as it appears below the desired
field.

Offline Configuration
When configuring the MCB 15x Safe Option in an offline
project mode, the configuration is stored in the project.
After completing the configuration, connect to the PC and
write to the frequency converter.

NOTICE
The LED status icons are not active in offline mode.

Online Configuration
Changed settings within Safe plug-in for MCB 15x Safe
Option are not applied before they are written to the
device.

1. Connect the Safe Plug-in for MCB 15x to the
frequency converter.

2. Press Write to drive to apply changed settings in
the Safe Plug-in. Writing the values to the
frequency converter always updates the entire
device package and not just the changed values.

NOTICE
If the Safe plug-in for MCB 15x Safe Option interface is
closed before the changes have been written to the
frequency converter, the changes will be lost.

13.4.1 Dependencies

Multiple configurable safety parameters depend on other
safety parameter values. The Safe plug-in for MCB 15x Safe
Option features notification dialogs that inform the user of
the possible consequences. It is then possible to verify the
changes and either accept or discard the change.
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Illustration 13.11 Dependencies Confirmation Dialog

When accepting the dependency dialog, both the change
that caused the dependency dialog and all other configu-
ration items listed in the dependency dialog are applied.
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13.4.2 Advanced Configuration Parameters

In the configuration area, the parameters section is a table format value entry for all configuration settings intended for
advanced users.
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Illustration 13.12 Parameters Configuration Tab

NOTICE
Prepare complete list of all configuration items and their respective values before commissioning.

13.4.3 Parameter Lists

Table 13.12 is a complete list of all parameters available to the user for configuration via Safe plug-in for MCB 15x.

NOTICE
Parameters ending with .0 are used for either SS1-A or SLS-A. The parameters ending with .1 are used for either SS1-b
or SLS-B in the groups 42-4 and 42-5.
For group 42-2 .0, refer to DI1 and .1 to DI2.
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Parameter Description Factory value
4210 Measured Speed Source – the source of the speed feedback. Safe Option

4211 Encoder Resolution – the resolution of the encoder connected to the Safe plug-in for MCB 15x. 1024

4212 Encoder Direction – the direction of the encoder. Clockwise

4213 Gear Ratio – the ratio between the motor speed and the encoder speed. 10.000

4214 Feedback Type – the feedback type. With direction info

4215 Feedback Filter – the frequency of the feedback filter. 200.00

4218 Zero Speed Timer – the timer for the zero speed activation. 10

4220.0 Safe Function – the safe function selected. STO

4220.1 Safe Function – the safe function selected. STO

4221.0 Type – the type of the safe input. NCNC

4221.1 Type – the type of the safe input. NCNC

4222.0 Discrepancy Time – the time amount allowed for discrepancy. 10

4222.1 Discrepancy Time – the time amount allowed for discrepancy. 10

4223.0 Stable Signal Time – the time amount for a stable signal. 10

4223.1 Stable Signal Time – the time amount for a stable signal. 10

4224.0
Restart Behaviour – the behaviour for the restarting of Safe plug-in for MCB 15x, automatic or with
user input. Manual

4224.1
Restart Behaviour – the behaviour for the restarting of Safe plug-in for MCB 15x, automatic or with
user input. Manual

4230 External Failure Reaction – the safety function that is executed in case of an external failure. STO

4231 Reset Source – the source for the reset signal. Drive Reset

4233
Parameter Set Name – the title for the current Safe plug-in for MCB 15x configuration. The
maximum length of the parameter set name is 8 symbols.  

4240.0 Type – type of the safe stop function. Delay

4240.1 Type – type of the safe stop function. Delay

4241.0
Ramp Profile – the ramp profile that is either defined by Safe plug-in for MCB 15x or within the
drive itself. Linear

4241.1
Ramp Profile – the ramp profile that is either defined by Safe plug-in for MCB 15x or within the
drive itself. Linear

4242.0
Delay Time – the amount of time used by the safe stop function to ramp the speed down to zero
RPM. 1.0

4242.1
Delay Time – the amount of time used by the safe stop function to ramp the speed down to zero
RPM. 1.0

4243.0 Delta T – the buffer time that is added to the delay time prior to activating STO. 2

4243.1 Delta T – the buffer time that is added to the delay time prior to activating STO. 2

4244.0 Deceleration Rate – the deceleration rate for the safe stop slope ramp type. 1500

4244.1 Deceleration Rate – the deceleration rate for the safe stop slope ramp type. 1500

4245.0
Delta V – the tolerance between the calculated and actual speeds allowed by Safe plug-in for MCB
15x. 120

4245.1
Delta V – the tolerance between the calculated and actual speeds allowed by Safe plug-in for MCB
15x. 120

4246.0 Zero Speed – the zero speed limit that Safe plug-in for MCB 15x will use to engage STO. 10

4246.1 Zero Speed – the zero speed limit that Safe plug-in for MCB 15x will use to engage STO. 10

4247.0 Ramp Time – the ramp time that Safe plug-in for MCB 15x will use to engage STO. 1.0

4247.1 Ramp Time – the ramp time that Safe plug-in for MCB 15x will use to engage STO. 1.0

4248.0
S-ramp Ratio at Deceleration Start – the proportion of the total ramp-down time wherein the
deceleration torque increases. The greater the percentage value, the greater the jerk compensation
achieved. 50

4248.1
S-ramp Ratio at Deceleration Start – the proportion of the total ramp-down time wherein the
deceleration torque increases. The greater the percentage value, the greater the jerk compensation
achieved. 50
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Parameter Description Factory value

4249.0
S-ramp Ratio at Deceleration End – the proportion of the total ramp-down time wherein the
deceleration torque decreases. The greater the percentage value, the greater the jerk compen-
sation achieved. 50

4249.1
S-ramp Ratio at Deceleration End – the proportion of the total ramp-down time wherein the
deceleration torque decreases. The greater the percentage value, the greater the jerk compen-
sation achieved. 50

4250.0 Cut Off Speed – the speed at which the Failsafe Reaction is engaged.  

4250.1 Cut Off Speed – the speed at which the Failsafe Reaction is engaged.  

4251.0 Speed Limit – the maximum speed allowed when the safe limited speed function is engaged.  

4251.1 Speed Limit – the maximum speed allowed when the safe limited speed function is engaged.  

4252.0 Fail Safe Reaction – the safety function that is activated when the speed exceeds the limit set. STO

4252.1 Fail Safe Reaction – the safety function that is activated when the speed exceeds the limit set. STO

4253.0
Start Ramp – if the speed at the activation of safe limited speed is greater than the speed limit,
the function either ramps down to the speed limit (Yes value) or activates the STO (No value.) No

4253.1
Start Ramp – if the speed at the activation of safe limited speed is greater than the speed limit,
the function either ramps down to the speed limit (Yes value) or activates the STO (No value.) No

4254.0 Ramp Down Time – the ramp down time for starting the ramp. 1.0

4254.1 Ramp Down Time – the ramp down time for starting the ramp. 1.0

Table 13.12 Parameter List
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13.5 Commissioning

1. Configure a Safe plug-in for MCB 15x.

2. Press Write to drive to upload to the frequency
converter

The following status window opens:
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Illustration 13.13 Writing to Drive Progress Window

3. Enter the password, when the Confirm password
dialog pops up (Default password : 12345678).
For more information on changing password,
refer to 13.6.3 Change Password
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Illustration 13.14 Password Entry Dialog

4. Press OK to continue OR press Cancel to discard
the process and perform a rollback.

NOTICE
When writing to a device in blank state, the user is
prompted to provide a new password for the device.
Have the appropriate default password available at
hand.

13
0B

C
94

6.
10

Illustration 13.15 Configuration Approval Dialog and Summary

Drives The top section of the summary displays all frequency
converters affected by the write procedure. In case of
multiple frequency converters, press the frequency
converter titles in the window to update Parameters
and CRC below accordingly.

Paramet
ers

This section details all the updated parameters that
were written to the frequency converter.

ID The parameter ID written.

Name The name of the parameter written.

New
values

The value of the parameter that was designated to be
written to the frequency converter. This column must
have the same value as Received values.  If not, an
error is displayed.

Received
values

The value that was received from the frequency
converter after the update procedure. This column
must have the same value as New values.  If not, an
error is displayed.

CRC This section displays the CRC values that were
generated from the application side and the
frequency converter side. These values must match. If
not, an error is displayed.

Table 13.13 Explanations for Illustration 13.15

5. When the Configuration approval pops up, review
the included summary.

6. Press Approve to confirm the changes and close
the dialog window, OR press Cancel to discard
the process and perform a rollback.

When the configuration has been approved, the commis-
sioning report is generated and displayed.
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Illustration 13.16 Commission Report Review, Save and Print
Dialog

7. Press Save to save the commission report in Rich
Text Format.

8. Press Print to print the report.

9. When the commissioning process is complete,
press [Reset] on the frequency converter to
reboot.

13.5.1 Commission Report

During the commission process, the commission report is
generated based on a fixed template within the MCT10
application. The report contains all data written to the
frequency converter.

The report is generated during the write-to-drive procedure
and the data are gathered at the moment the report is
generated. This report contains the functions that need to
be tested, see more details in MCB 15x Safety Option
Operating Instructions.

The contents and structure of the commissioning report
are as follows:

• General Introduction – general information and
details about the report itself.

• Commissioning Configuration – details regarding
the commissioned set-up and parameter configu-
rations.

• Commissioning Test – specific testing scenarios
for the current set-up. This section also contains
CRC check procedure descriptions

13.6 Operation

The following describes how to use the diagnosics
function, how to reset and how to change password

13.6.1 Diagnostics

Follow these instructions to access and use the Diagnostics
function:

1. Open the Safe plug-in for MCB 15x plug-in
interface in network online mode.

2. Press Administration in the upper section of the
interface. The following window opens:
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Illustration 13.17 Safe Plug-in for MCB 15x Administration
Window

3. Enter the Safe plug-in for MCB 15x password
configured for the frequency converter.

4. Press Download to download the Safe plug-in for
MCB 15x event log.

5. Select a location to save the log file. The log is
presented in simple text file format.

13.6.2 Reset

Follow these instructions to access and use the Reset
function:

NOTICE
Resetting the device restores factory settings and erases
any customized configuration on the device. To ensure
rollback possibility, back up the customized configu-
ration before resetting

1. Open the Safe plug-in for MCB 15x plug-in
interface in network online mode.

2. Click Administration in the upper section of the
interface.

3. Click the Reset tab header to open the Reset tab.
The following window opens:
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Illustration 13.18 Reset Password

4. Select the option Yes, I want to reset Safe plug-in
for MCB 15x Configuration for the frequency
converter to continue

5. Enter the master password configured for the
frequency converter to continue.

6. Press Reset to reset the frequency converter
password and configuration.

7. Press [Reset] on the frequency converter to
reboot.

13.6.3 Change Password

When working with the Safe plug-in for MCB 15x plug-in
in network online mode, Change password is displayed in
the information area of the plug-in interface.
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Illustration 13.19 Safe Plug-in for MCB 15x Password Changing
Window

Follow these instructions to change the password:

1. Press Change password.

2. Enter the current password into the Current
password field.

3. Enter the new desired password into the  New
password field.

4. Confirm the new desired password by entering it
again into the Confirm new password field. The
password length must be exactly 8 characters.
The password is case sensitive.

5. If necessary, select the option Confirm to all blank
initial drives to apply the new password to all
new drives in the network.

6. Press Cancel to discard the procedure.
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14 SyncPos

14.1 SyncPos Handling

The VLT 5000 and VLT 5000 FLUX series have a SyncPos
application option, which consists of a print card with
processor. For detailed information, refer to the separate
SyncPos program manual.

MCT 10 Set-up Software can directly modify, read from and
write to SyncPos files. SyncPos Files are stored within the
MCT 10 Set-up Software files, and do not require separate
handling.

When a VLT 5000 has a SyncPos option installed, the MCT
10 Set-up Software displays 2 icons upon selection of the
frequency converter: an All Parameters folder icon and a
separate icon for the SyncPos option. A group 7 series of
parameters is incorporated under All Parameters. The group
7 parameters apply to SyncPos.

NOTICE
MCT 10 Set-up Software does not fully support the
SyncPos application versions 1.xx and 2.xx. The Syncpos
folder is available due to the lack of functionality in
these initial versions.

14.2 Programs and Configuration File

The SyncPos program consists of two main parts: Configu-
ration file (*.cnf) and Program Files(s) (*.m). A configuration
file consists of a series of SyncPos parameters which can
be programmed. MCT 10 Set-up Software allows importing,
exporting and setting up SyncPos Configuration files.

14.2.1 Programs

Programs can be inserted in the MCT 10 Set-up Software
Project folder. When a new SyncPos program is selected,
an untitled program is inserted in the SyncPos folder. The
program can be edited, written and exported just as in the
stand alone SyncPos program. If a SyncPos program
already exists it can be imported into the MCT 10 Set-up
Software project.

14.2.2 Configuration

1. Select Configuration to view the available
frequency converter configuration file in the Right
View.

2. To change the SyncPos settings, select the
relevant frequency converter in the Right View to
open a new editor (Cam Editor). Refer to the
separate SyncPos Operating Instructions for
details on using the editor.

3. Once the desired settings are made, select
Compile (under Settings in the main menu) or Exit
Program (under File in the main menu).

4. When selecting Exit Program, select Read or Write.
The Confirm SyncPos Write (or Read)-window pops
up with 2 options for saving to the SyncPos card.
Mark the desired selection and select Yes or No.
When selecting Yes, the information is written to
the frequency converter.

NOTICE
If Write to Drive is selected at the root of a frequency
converter, the MCT 10 Set-up Software also writes the
SyncPos Files to the SyncPos options. This can lead to an
unattended stop of the SyncPos Card.

14.2.3 Import and Export of a
Configuration File

To import a configuration file saved elsewhere, for
example in another project, to the SyncPos card:

1. Click on the configuration file displayed in the
Right, see Illustration 14.1.

2. Select a configuration file for import from the
computer directory.

3. Select the desired file and click Open to import
the file to the Configuration folder.

Illustration 14.1 Import Configuration File
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Illustration 14.2 Import Configuration File

Export of configuration files is performed in the same
manner.

14.2.4 Edit and Save Configuration File

View and edit the content of the configuration file by
selecting it, whereupon the configuration editor opens.

After editing is complete, close the SyncPos application
and the following window pops up:

Illustration 14.3 SyncPos Application Closed

Select Read to save changes to the MCT 10 Set-up
Software project, or Write to save changes to the
frequency converter. Reading or Writing can take some
time.

14.2.5 Import and Export of Programs

To import a program to the SyncPos card, left-click on a
program displayed in the Right View as shown in
Illustration 14.4.

Illustration 14.4 Import Program to SyncPos Card

Browse the computer to find the desired program for
import.

Illustration 14.5 Browse

Select the desired program, click Open to import program
in the Programs folder. The import is now complete.

14.2.6 Autostart

If more than one program is stored in the Programs folder,
it is possible to set one of them to start automatically
when the device is turned on.

In the Right View, select the start-up program, and then
right-click to select Set As Autostart. The program selected
is thereafter indicated with Yes in the Autostart column.

Illustration 14.6 Autostart

14.2.7 Source Code

Refer to SyncPos manual.
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14.2.8 Edit Source Code

Double-click Program in the Right View to view and edit
the source code.

Illustration 14.7 View/Edit Source Code

A range of editing operations are possible, described in
detail in the SyncPos manual.

14.2.9 Save and Exit Program

Select File ⇒ Save in the menu bar to save the changes to
the program file opened from the MCT 10 Set-up Software
project.

To leave SyncPos, select File ⇒ Exit Program in the menu
bar:

Illustration 14.8 Exit Program

As for editing of a configuration file, a SyncPos Application
Closed dialog box pops. Select Read or Write according to
the instructions in the box.

NOTICE
If there are programs in the SyncPos card they
are deleted without further warning.

Illustration 14.9 Confirm SyncPs Write

14.3 SyncPos Read From Drive

Read all parameters and SyncPos files from a frequency
converter to a project by selecting Read from Drive. Select
the root drive and then right-click to find Read from Drive:

Illustration 14.10 SyncPos Read From Drive

NOTICE
Files in the project can be permanently lost, as files of
the same name will be permanently overwritten:

Illustration 14.11 Files Overwritten

Select Yes to commence reading from the frequency
converter and to save configuration files and programs
from the frequency converter to the project.
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14.4 SyncPos Write to Drive

Write all parameters and SyncPos files from a project to a
frequency converter by selecting Write to Drive. Select the
root drive and then right-click to find Write to Drive:

Illustration 14.12 Write to Drive

CAUTION
Use this feature with caution. If incorrectly used, files on
the frequency converter can be permanently lost. The
following warning appears, explaining that files of the
same name are permanently overwritten:

Illustration 14.13 Warning Files Overwritten

Select the required settings and select Yes to commence
writing. For the above settings, the existing programs are
deleted. Then the SyncPos Program Source Files are written
to the frequency converter. Once the write is complete,
check the contents for the Network folder to confirm that
the Write to Drive was successful.
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15 Troubleshooting

15.1 Save Error Dialog

When an error dialog appears on the screen MCT 10 Set-
up Software has a facility for saving to a text file to record
the error message for later reference, for example to
obtain help from Support. Within the error dialog window,
select Save As to record the error message as a text file
with free choice of file name and location.

For example, when scanning the network for frequency
converters, an error dialog appears showing the frequency
converters not detected:

Illustration 15.1 Not detected Frequency Converters

Select Save As to store the error log and the following
dialog appears.

Illustration 15.2 Store Error Log

15.2 Common Problems and Solutions

15.2.1 Changes Are Not Saved to PC

Checks that changes made in the Network folder have
been copied to the Project folder, and then saved to a hard
disk. Changes made in the Network folder are implemented
in the field device only, and are not automatically saved to
a PC.

15.2.2 Error Message Whilst Installing MCT
10 Set-up Software

A message such as MCT 10 Set-up Software SET UP
SOFTWARE ERROR OPENING FC DRIVER may occur, if there is
a second PC program installed, using the same COM port
of the PC. Such a program could be a PLC programming
tool, Palm pilot driver or Cellular Phone driver etc.
Investigate whether other programs use the same COM
port. If this is the case, ensure that the other PC tool does
not lock or reserve the COM port.

Error message whilst storing parameter settings and
reading/writing via Profibus DP-V1 using the function
database readout from the frequency converter.
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15.2.3 Error Message Communication Failed

The communications error comes and goes sporadically
This type of communications error typically occurs when cables are inadequately screened, in which case EMC noise can
affect the communications. Check that the cables are installed according to the guidelines in the Operating Instructions for
the frequency converter.

The communications error is permanent
This type of communications error is typically due to an error in network configuration. Check that the network configu-
ration is in accordance with the frequency converter Operating Instructions guidelines.

Communication failed
The Communication Failed error message appears in the status bar as shown inIllustration 15.3.

Illustration 15.3 Error Message: Communication Failed
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15.2.4 Communication Errors 

If an erroneous/illegal action has been attempted, an error highlight appears in the status bar at the bottom of the MCT 10
Set-up Software window.

When a communications error arises, the status bar at the bottom of the MCT 10 Set-up Software window is highlighted
and displays a Communications Failed error message, as shown in Illustration 15.4

Illustration 15.4 Error Message: Communication Failed

When no communications error has occurred the same window appears as
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Illustration 15.5 Communication OK

Communications errors typically occur due to inadequate screening of cables, i.e. cable is not installed in accordance with
installation instructions.

15.2.5 Help

Select Help ⇒ Help in the main menu. A Help file is opened,
displaying the MCT 10 Set-up Software manual in .pdf
format. Acrobat Reader software is required to open the
manual. It can be downloaded free of charge at
www.adobe.com.

15.3 Safe Plug-In

This section contains common troubleshooting and known
error descriptions.

15.3.1 Troubleshooting Communication
Errors

During commission, the communication between MCT 10
Set-up Software and the frequency converter can fail. The
user is notified of this failure via a message.

Confirm the status of the communication devices and the
frequency converter as well as the status of the frequency
converter to guarantee proper communication.

15.3.2 Troubleshooting CRC Errors

CRC errors can occur during the write to drive procedure.
Should a CRC error occur, try to write to the frequency
converter again.

When the CRC errors persist, verify the integrity of the
devices and communication.
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15.3.3 Device Error Codes

The following is a complete list of all error codes that can appear within the Safe plug-in for MCB15x plugin and their
respective descriptions.

Error
No. Description

Led Indications 
  LED1 LED 2 LED4

 Internal failure Reason Action

Status of LED 1 and LED2 depends on safety
function state assigned to DI1 and DI2

respectively

Green
Constant

1 Diagnostic in
progress

 Green
Constant

67 Int Fail
tolerance error
exceeded:
Reaction STO

• Check that data for
feedback (ppr., Type of
feedback and gear
ratio) are entered
correctly

• Direction of feedback
is wrong.

• Due to use of
feedback filter the
dynamic of the system
does not match with
dynamic of feedback
filter (42-15 Feedback
Filter). System is
ramping too fast.

• Feedback signals are
not received at all.

• No correction
shielding of feedback
cables.

   

• Make a re-customi-
sation with correct
data if needed

• Set 42-12 Encoder
Direction to the
opposite value.

• Decrease ramping
time on frequency
converter

• Try to run the
system at e.g. 60
RPM. If error nr. 99
now occurs, this is
the reason.

• Improve shielding
of feedback cables
and motor cables.

     

Red Constant

68 Int fail Speed
limit SS1a
Ramp: Reaction
STO

• The value of Δ V is
too small. For closed
loop system it must
often be larger than
the recommended
value.

• Due to use of
feedback filter the
dynamic of the system
does not match with
dynamic of feedback
filter (42-15 Feedback
Filter).

• Load change takes
place during ramping.

   

• If running in closed
loop, try to adjust
PID setting and if
needed increase
SS1 ramping time. 

• Try to increase
42-15 Feedback
Filter,  but this
might cause error
nr. 67 to occur.

•  Otherwise increase
42-45 Delta V.

Red Constant

69 Int fail Speed
limit SS1b
Ramp: Reaction
STO

See 68 See 68 Red Constant
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Error
No. Description

Led Indications 
  LED1 LED 2 LED4

 Internal failure Reason Action

Status of LED 1 and LED2 depends on safety
function state assigned to DI1 and DI2

respectively

Green
Constant

70 Int fail speed
limit SLSa :
Reaction STO

Happens during ramping
to SLS limit, see 68.
Happens during speed
below SLS limit:

• If speed is above Cut
Off speed at activation
point and 42-53 Start
Ramp is set to “No”,
this error occurs.

• Noise on the feedback
signal (incl. quanti-
sation noise) is larger
that expected.

• Load change takes
place, do as in above
point)

• Change 42-53 Start
Ramp to “Yes” and
set 42-54 Ramp
Down Time
accordingly.

• Increase 42-50 Cut
Off Speed or
decrease
42-51 Speed Limit
to get a larger
tolerance

   

Red Constant

134 Int fail speed
limit SLSa:
Reaction SS1a

See 70 See 70 Red Constant

198 Int fail speed
limit
SLSa :Reaction
SS1b

See 70 See 70 Red Constant

71 Int fail speed
limit SLSb :
Reaction STO

See 70 See 70 Red Constant

135 Int fail speed
limit
SLSb :Reaction
SS1a

See 70 See 70 Red Constant

199 Int fail speed
limit
SLSb :Reaction
SS1b

See 70 See 70 Red Constant

72 Int Fail
Processor
Failure: Reaction
STO

• The two processos on
MCB 15x have
different safety states.

• CPU 2 fails

   

• First power cycle
the frequency
converter or restart
the MCB 15x by
42-90 Restart Safe
Option. Secondly
try to make a
general reset of
the MCB 15x with
the “Adminis-
tration” button
(MCB 15x goes
back to blank
initial state)

• If the problem
persists, contact
Danfoss

   

Red Constant
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Error
No. Description

Led Indications 
  LED1 LED 2 LED4

 Internal failure Reason Action

Status of LED 1 and LED2 depends on safety
function state assigned to DI1 and DI2

respectively

Green
Constant

73 Int Fail safe
output switch1:
Reaction STO

Diagnostic of safe output
of CPU 1 fails.

• First power cycle
frequency
converter or restart
the MCB 15x by
42-90 Restart Safe
Option.

• If the problem
persists, contact
Danfoss

Red Constant

74 Int Fail safe
output switch2:
Reaction STO

Diagnostic of safe output
of CPU 2 fails.

• First power cycle
frequency
converter or restart
the option by
42-90 Restart Safe
Option.

• If the problem
persists, contact
Danfoss

Red Constant

75 Int Fail DI2 in
PUST: Reaction
STO

• Safety input connected
to DI2 has illegal
signal level.

• Sensor is broken

• Check that configu-
ration of DI2
(42-21 Type sub
index [1] is set
correctly or the
connected sensor
is installed
according to
specification.

Red Constant

76 Int Fail DI1 in
PUST: Reaction
STO

• Safety input connected
to DI1 has illegal
signal level.

• Sensor is broken

• Check that the
configuration of
DI1 (42-21 Type sub
index [1] is set
correctly or the
connected sensor
is installed
according to
specification.

Red Constant

77 Int Fail failsafe
data CRC
mismatch:
Reaction STO

The CRC of the MCB 15x
does not match the
stored CRC value on the
frequency converter.

Configure the MCB
15x with MCT 10 safe
plug-in or by CRC
select/LCP copy 

Red Constant

78 Int Fail
S1S2CommChan
nel: Reaction
STO

The communication
between CPU 1 and CPU
2 fails.

• First power cycle
frequency
converter or restart
the MCB 15x by
42-90 Restart Safe
Option.

• If the problem
perists, contact
Danfoss

Red Constant

79 Int Fail No SPI
comm: Reaction
STO

 Contact Danfoss Red Constant

Table 15.3

Troubleshooting VLT® MCT 10 Set-up Software

MG10RA02 - VLT® is a registred Danfoss trademark 121

15 15



Error
No. Description

Led Indications 
  LED1 LED 2 LED4

 Internal failure Reason Action

Status of LED 1 and LED2 depends on safety
function state assigned to DI1 and DI2

respectively

Green
Constant

80 Int Fail No CAN
comm: Reaction
STO

 Contact Danfoss Red Constant

81 Int Fail under
voltage Vuc1:
Reaction STO

Voltage for CPU 1 is too
low.

• First power cycle
frequency
converter.

• If the problem
persists, contact
Danfoss

Red Constant

82 Int Fail
overvoltage
Vuc1: Reaction
STO

Voltage for CPU 1 is too
high.

• First power cycle
frequency
converter.

• If the problem
persists, contact
Danfoss

Red Constant

83 Int Fail
undervoltage 24
V IO: Reaction
STO

Voltage for terminal 12
safe output is too low.

• First power cycle
frequency
converter.

• If the problem
persists, contact
Danfoss

Red Constant

84 Int Fail
overvoltage 24v
IO: Reaction
STO

Voltage for terminal 12
safe output is too high.

• First power cycle
frequency
converter.

• If the problem
persists, contact
Danfoss

Red Constant

85 Int Fail
undervoltage
Vuc2: Reaction
STO

Voltage for CPU 2 (GPIO)
is too low.

• First power cycle
frequency
converter.

• If the problem
persists, contact
Danfoss

Red Constant

86 Int Fail
overvoltage
Vuc2: Reaction
STO

Voltage for CPU 2 (GPIO)
is too high.

• First power cycle
frequency
converter.

• If the problem
persists, contact
Danfoss

Red Constant

87 Int Fail
undervoltage
int5v: Reaction
STO

Voltage used for other
circuits than CPU is too
low.

• First power cycle
frequency
converter.

• If the problem
persists, contact
Danfoss

Red Constant
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Error
No. Description

Led Indications 
  LED1 LED 2 LED4

 Internal failure Reason Action

Status of LED 1 and LED2 depends on safety
function state assigned to DI1 and DI2

respectively

Green
Constant

88 Int Fail
overvoltage
int5v: Reaction
STO

Voltage used for other
circuits than CPU is too
high.

• First power cycle
frequency
converter.

• If the problem
persists, contact
Danfoss

Red Constant

89 Int Fail Memory
Fail S2: Reaction
STO

• Data in EEPROM for
CPU 2 is corrupted.

• The Flash memory
fails.

• Try to perform a
general reset of
the MCB 15x with
the “Adminis-
tration” button.

• If the problem
persists, contact
Danfoss

Red Constant

90 Int Fail Memory
Fail S1: Reaction
STO

• Data in EEPROM for
CPU 1 is corrupted.

• The Flash memory
fails.

• Try to perform a
general reset of
the MCB 15x with
the “Adminis-
tration” button.

• If the problem
persists, contact
Danfoss

Red Constant

91 Int Fail
undervoltage
Vuc2 PLL:
Reaction STO

Voltage for CPU2 (PLL) s
too low.

• First power cycle
frequency
converter.

• If the problem
persists, contact
Danfoss

Red Constant

92 Int Fail
overvoltage
Vuc2 PLL:
Reaction STO

Voltage for CPU2 (PLL) is
too high.

• First power cycle
frequency
converter.

• If the problem
persists, contact
Danfoss

Red Constant

93 Int Fail
undervoltage
Vuc2 Core:
Reaction STO

Voltage for CPU2 (Core) s
too low.

• First power cycle
frequency
converter.

• If the problem
persists, contact
Danfoss

Red Constant

94 Int Fail
overvoltage
Vuc2 Core:
Reaction STO

Voltage for CPU2 (Core) is
too high.

• First power cycle
frequency
converter.

• If the problem
persists, contact
Danfoss

Red Constant
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Error
No. Description

Led Indications 
  LED1 LED 2 LED4

 Internal failure Reason Action

Status of LED 1 and LED2 depends on safety
function state assigned to DI1 and DI2

respectively

Green
Constant

95 Int Fail
undervoltage
Vuc2 SDRAM:
Reaction STO

Voltage for CPU2 (SDRAM)
s too low.

• First power cycle
frequency
converter.

• If the problem
persists, contact
Danfoss

Red Constant

96 Int Fail
overvoltage
Vuc2 SDRAM:
Reaction STO

Voltage for CPU2 (SDRAM)
is too high.

• First power cycle
frequency
converter.

• If the problem
persists, contact
Danfoss

Red Constant

97 Int Fail MOC Fail
S1: Reaction
STO

 • Contact Danfoss Red Constant

98 Int fail invalid
customer file
version

Version of customisation
file of MCB 15x stored in
EEPROM does not match
the customisation file
supported by the SW
version of MCB 15x.

Do a new configu-
ration with MCT 10
safe plug-in which
supports the SW
version of MCB 15x. 

 

99 Int Fail
Feedback error

The connected feedback
source does not give any
signal. 

Check to connection is
done according to the
specification or if the
feedback source is
broken.

Red

113 Ext Fail DI1 :
Reaction STO

• Safety input connected
to DI1 has illegal
signal level.

• Sensor is broken.

Check that configu-
ration of DI1
(42-21 Type sub index
[0] is set correctly or
the connected sensor
is installed according
to specification

Red Constant

Status depends on
safety function state
assigned to DI2

Red flashing,
cycle (on 500
ms, off 500
ms)

177 Ext Fail
DI1 :Reaction
SS1a

See 113 See 113 Red Constant Red flashing,
cycle (on 500
ms, off 500
ms)

241 Ext Fail
DI1 :Reaction
SS1b

See 113 See 113 Red Constant Red flashing,
cycle (on 500
ms, off 500
ms)

114 Ext Fail DI2 :
Reaction STO

• Safety input connected
to DI2 has illegal
signal level.

• Sensor is broken

Check that configu-
ration of DI2
(42-21 Type sub index
[1] is set correctly or
the connected sensor
is installed according
to specification

Status depends on
Safety function state
assigned to DI1

Red Constant Red flashing,
cycle (on 500
ms, off 500
ms)
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Error
No. Description

Led Indications 
  LED1 LED 2 LED4

178 Ext Fail
DI2 :Reaction
SS1a

See 114 See 114 Status depends on
Safety function state
assigned to DI1

Red Constant Red flashing,
cycle (on 500
ms, off 500
ms)

242 Ext Fail
DI2 :Reaction
SS1b

See 114 See 114 Status depends on
Safety function state
assigned to DI1

Red Constant Red flashing,
cycle (on 500
ms, off 500
ms)

115 Ext Fail Prec
Thresh Timer
Elapsed :
Reaction STO

The frequency converter
has been running below
120 RPM for more than
the time entered in
parameter 42-18 Zero
Speed Timer with safe
function SLS active. 

Increase speed to
above 120 RPM.

Status of LED 1 and LED2 depends on Safety
function state assigned to DI1 and DI2

respectively

Red flashing,
cycle (on 500
ms, off 500
ms)

179 Ext Fail Prec
Thresh Timer
Elapsed
:Reaction SS1a

See 115 See 115 Red flashing,
cycle (on 500
ms, off 500
ms)

243 Ext Fail Prec
Thresh Timer
Elapsed
:Reaction SS1b

See 115 See 115 Red flashing,
cycle (on 500
ms, off 500
ms)

116 Ext Fail SF
activation
Speed
Suspension :
Reaction STO

The frequency converter
has been running below
120 RPM for more that 1
year and a safety function
that need speed feedback
is activated.

Increase speed to
above 120 RPM.

Red flashing,
cycle (on 500
ms, off 500
ms)

180 Ext Fail SF
activation
Speed
Suspension:
Reaction SS1a

See 116 See 116 Red flashing,
cycle (on 500
ms, off 500
ms)

244 Ext Fail SF
activation
Speed
Suspension
:Reaction SS1b

See 116 See 116 Red flashing,
cycle (on 500
ms, off 500
ms)

252 Safe Option
Failure
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